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ВВЕДЕНИЕ  

 

Компьютерная графика – технология создания и обработки 

графических изображений средствами вычислительной техники. 

Компьютерная графика изучает методы получения изображений 

полученных на основании невизуальных данных или данных, со-

зданных непосредственно пользователем. 

Изучение курса способствует формированию простран-

ственного мышления, раскрывает роль компьютерных техноло-

гий в создании и обработке горно-графической документации, 

прививает навыки сознательного, рационального использования 

компьютера в профессиональной деятельности. 
Целью лабораторных занятий является: 

- ознакомление студентов с современными средствами ком-

пьютерной графики; 

- изучение основ работы с графическим редактором Autocad, 

освоение методов автоматизированного решения горных инже-

нерных задач; 

.- практическое освоение студентами технологии разработки 

графических  документов, реализованной в среде универсальной 

графической системы AutoCAD посредством выполнения графи-

ческих и домашних заданий. 

 

План лабораторных занятий 

 

Методические указания к выполнению лабораторных заня-

тий по дисциплине «Компьютерная графика» предназначены для 

студентов специальности «Горное дело», образовательные про-

граммы: «Открытые горные работы», «Технологическая безопас-

ность и горноспасательное дело», очной формы обучения. 

Методические указания «Компьютерная графика» составле-

ны в соответствии с рабочей программой дисциплины. Програм-

ма курса предусматривает наряду с лекционной частью проведе-

ние лабораторных занятий. План лабораторных занятий пред-

ставлен в таблице 1. 
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Таблица 1 – План лабораторных занятий 
Неделя 

семестра 

Тема занятия Объем 

в часах 

1 ЛЗ 1. Основы графического пакета AutoCAD.  
Запуск AutoCAD. Создание нового чертежа (стартовое окно). Поль-

зовательский интерфейс. Сохранение чертежа. Создание нового 

чертежа на основе шаблона. Создание слоев. Изменение цвета, типа 

и толщины линий объекта. Командная строка и система динамиче-

ского ввода [1, 2, 4, 5] 

2/0,054 

2 

 
ЛЗ 2. Изучение панели черчения (рисования). 

 Создание простых и сложных примитивов. Нанесение штриховки. 

Установка и редактирование текста[1, 2, 4, 5].  

Выполнение графических заданий по текущей теме   

 

 

 

 

4/0,112

5 
ЛЗ 3. Изучение панели модификации (редактирования). Коман-

ды «фаска» и «сопряжение». 

Редактирование простых и сложных примитивов. Сопряжение гра-

фических примитивов дугой. 

Разбор конкретного примера графического задания по текущей те-

ме[1, 4, 5]. Выдача ДЗ № 1 «Сопряжение»  

3 ЛЗ 4. Изучение панели модификации (редактирования). Созда-

ние массива объектов. 

Изучение команды «массив объекта». Разбор конкретного примера 

по текущей теме [1, 2, 4, 5].  

Выдача ДЗ  № 2 «Создание массива объекта»  

2/0,054 

4 

 
ЛЗ 5. Текстовые стили. 

Ознакомление с настройкой текстовых параметров, текстовых 

стилей. Настройка и редактирование текстового стиля [1, 2, 4, 5] 

Выполнение графического задания по текущей теме  «Текстовые 

стили в AutoCAD»  

2/0,054 

ЛЗ 6. Размерные стили. 

Настройка размерных параметров. Настройка размерных стилей. 

Диаметр и радиус окружности. Простановка размеров фаски. Ре-

дактирование размеров. Изменение параметров размеров. Измене-

ние размерного текста. Изменение положения размера [1, 2, 4, 5]. 

Нанесение размеров в ДЗ № 1 и № 2 [3, 4] 

2/0,054 

5-7 ЛЗ 7. Блоки и атрибуты блоков. 

Создание локального и автономного блоков. Взаимодействие слоев 

блока и чертежа. Создание блока с атрибутами [1, 2, 4, 5]. 

Выполнение графического задания «Создание блока основной 

надписи» 

Текущий контроль (на 5-ой неделе по темам ЛЗ №1, №2, №3 и те-

мам лекций № 1.1–4.1). 

ЛЗ 8 Видовые экраны. 

Понятие видового экрана. Основные настройки, создание видового 

экрана, масштабирование видового экрана. Переход в пространство 

МОДЕЛЬ. Область отображения видового экрана, подрезка и бло-

кировка видового экрана. Отключение рамки видового экрана. От-

ключение слоев в видовых экранах [1, 2, 4, 5]. 

8/0,216 
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Выполнение графической работы «Работа с видовыми экранами»  

ЛЗ  9. Вывод чертежа на печать.  

Стили печати. Конфигурирование печатающих устройств. Печать 

чертежа. [1, 2, 4, 5, 8] 

Выполнение графической работы «Построение рабочего уступа и 

его элементов» 

8-9 Лз 10. Построение технологической схемы торцевого забоя 

мехлопаты при погрузке горной массы в автотранспорт на 

уровне стояния (отработка мягких и плотных пород). [1, 2, 4, 5, 

8, 9] 

Мультимедийная  презентация примеров выполнения практических 

работ. Разбор конкретных примеров графических работ. 

Текущий контроль (на 9 –ой неделе по темам ЛЗ №4, №5, №6 и те-

мам лекций № 5.1–8.2).  

6/0,162 

 

 

 

 

10-11 Лз 11. Построение технологической схемы работы мехлопаты 

при разработке мягких пород в траншейном забое (верхним 

черпанием и погрузкой в средства транспорта на уровне стоя-

ния экскаватора) [1, 2, 4, 5, 8, 9] 

Мультимедийная  презентация примеров выполнения практических 

работ. Разбор конкретных примеров графических работ. 

6/0,162 

12-13 Лз 12. Технологическая схема работы мехлопаты при разработ-

ке мягких пород в траншейном забое (верхним черпанием и 

верхней погрузкой в средства транспорта) [1, 2, 4, 5, 9, 10, 11] 

Мультимедийная  презентация примеров выполнения практических 

работ. Разбор конкретных примеров графических работ. 

Текущий контроль (на 13-ой неделе по темам ЛЗ №7, №8 и темам 

лекций №9.1-11.2).  

8/0,216 

14 Лз 13. Схема проведения разрезной траншеи по мягким поро-

дам нижним черпанием гидравлическим экскаватором типа 

обратная лопата с погрузкой на уровне стояния экскаватора [1, 

2, 4, 5, 8, 9, 10] 

4/0,112

5 

15 Лз 14. Безтранспортная схема с установкой драглайна на раз-

вале [1, 2, 4, 5, 8, 9, 10] 

2/0,054 

16-17 Лз 15. Схема работы мехлопаты при разработке взорванных 

пород в траншейном забое при погрузке на уровне стояния экс-

каватора [1, 2, 4, 5, 8, 9, 10]. 

Мультимедийная  презентация примеров выполнения практических 

работ. Разбор конкретных примеров графических работ. 

Текущий контроль (на 17-ой неделе по темам ЛЗ №9 и лекций № 

1.1–11.2).  

6/0,162 

 Всего 52/1,44 
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Лабораторное занятие № 1 

«Основы графического пакета AutoCAd» 
 

Цель занятия: 

- ознакомиться с пользовательским интерфейсом и основами 

графического редактора AutoCAD; 

- научиться выполнять запуск программы, создавать и со-

хранять чертеж; создавать новый чертеж на основе шаблона;  

- ознакомиться с функциями командной строки и системой 

динамического ввода. 
 

1. Теоретические положения 

1.1 Запуск программы AutoCAD 
 

Программа AutoCAD уже многие годы является одним из 

наиболее мощных и широко распространенных инструментов 

проектирования. С выходом каждой новой версии возможности 

программы становятся все шире, элементы управления модерни-

зируются, появляются новые. 
Как и любое приложение, запуск программы AutoCAD 

можно осуществить несколькими способами. Рассмотрим наибо-

лее распространенные из них: 

• Использование меню Пуск. Для запуска программы нужно 

выполнить команду Пуск > Все программы > Autodesk > 

AutoCAD 2009> AutoCAD 2009. 

• Использование ярлыка программы на Рабочем столе. Для 

запуска приложения достаточно найти на Рабочем столе его яр-

лык и дважды щелкнуть на нем кнопкой мыши. 

• Если вы хотите не просто запустить программу, а открыть 

определенный файл чертежа, необходимо открыть Проводник 

или любой другой файловый менеджер, с его помощью найти 

нужный вам файл и запустить его. В результате загрузится 

AutoCAD и откроется требуемый файл, а если вы уже запустили 

программу ранее, то просто откроется нужный файл. 

• По умолчанию программа AutoCAD не создает ярлык на 

панели быстрого запуска, однако вы можете сделать это, перета-

щив туда ярлык с Рабочего стола или из меню Пуск при нажа-
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той клавише Ctrl. Запуск приложения с данной панели удобен 

тем, что для этого не нужно открывать меню. Кроме того, панель 

быстрого запуска всегда отображается на экране, в то время как 

Рабочий стол может быть закрыт запущенными приложениями. 

 

1.2 Интерфейс программы AutoCAD 

 

Окно программы AutoCAD состоит из нескольких частей, 

каждая из которых выполняет определенные функции: ввод ко-

манд, отображение необходимой при черчении информации и т. 

д. Некоторые инструменты взаимодополняют и даже могут за-

мещать друг друга. 
Центральная область рабочего окна программы называется 

графическим экраном. В этой области выполняются все построе-

ния. На графическом экране указатель мыши приобретает вид пе-

рекрестья (рисунок 1) и способен выполнять функции, использу-

емые в проектировании: привязка к объектам, задание координат 

и направления. При выходе за границы графического экрана ука-

затель приобретает привычный вид. 

AutoCAD имеет три основных вида интерфейса:  

1. Меню (File, Edit, View…);  

2. Панели инструментов;  

3. Командная строка.  

1. Строка меню включает в себя множество пунктов для 

вызова различных команд и открытия диалоговых окон. 

Рассмотрим имеющиеся в программе пункты меню. 

• File (Файл). Здесь находятся команды обработки файлов: 

создания, сохранения, восстановления. Кроме того, это меню со-

держит команды, используемые для печати документов. 

• Edit (Правка). Пункты данного меню позволяют выпол-

нять стандартные для Windows операции работы с буфером об-

мена (вырезать, копировать, вставить), а также специальные 

вставки. Здесь также расположены команды поиска, выделения и 

удаления. 
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Рисунок 1 – Интерфейс программы AutoCAD 

 

• View (Вид). С помощью команд данного меню вы можете 

управлять отображением объектов на экране. Здесь расположены 

такие подменю, как Zoom (Зумирование), Pan (Панорамирова-

ние) и др. В этом же меню находятся команды регенерации чер-

тежей. Кроме того, меню View (Вид) содержит команду Toolbars 

(Панели), при выборе которой на экране отображается диалого-

вое окно Customize User Interface (Настройка интерфейса поль-

зователя); с помощью данного окна вы сможете создавать соб-

ственные меню, панели инструментов, назначать сочетания кла-

виш для быстрого вызова команд и окон, а также редактировать 

имеющиеся. Более подробно об этом диалоговом окне будет рас-

сказано ниже. 

• Insert (Слияние). Команды этого меню позволяют встав-

лять в поле чертежа блоки и объекты, созданные ранее в сторон-
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них приложениях, а также импортировать в AutoCAD различные 

файлы. 

• Format (Формат). Данное меню предназначено для вызова 

диалоговых окон, помогающих определить множество парамет-

ров черчения. Последняя команда, Rename (Переименовать), 

служит для переименования различных объектов программы, та-

ких как слои, материалы, блоки и др. 

• Tools (Сервис). Здесь вы можете изменять различные 

настройки программы, вызывать на экран вспомогательные окна, 

а также загружать внешние приложения и управлять ими. В этом 

же меню находится группа команд для работы с макросами, со-

здаваемыми на языке программирования VBA. 

Подменю Workspaces (Рабочие пространства) предоставля-

ет доступ к рабочим пространствам программы. Оно служит для 

переключения между пространствами, а также для их настройки 

и сохранения. 

 

2. Панели инструментов являются графическим интерфей-

сом команд программы AutoCAD. Визуально это графические 

кнопки, вызывающие соответствующие им команды. Помимо 

графического изображения, о назначении кнопки вы можете 

узнать, подведя к ней указатель мыши. На экране появится 

всплывающая подсказка с кратким описанием команды. Если для 

команды назначено сочетание клавиш быстрого вызова, оно так-

же будет показано во всплывающей подсказке. На рисунке 2 по-

казана панель инструментов Standard (Стандартная) с указате-

лем мыши, наведенным на кнопку Save (Сохранить). 

Многие кнопки на панелях инструментов дублируют коман-

ды на ленте или в меню (если вы работаете с классическим ин-

терфейсом программы). Пользователь может выбрать более 

удобный для него способ вызова команды. 
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Рисунок 2 – Панель инструментов Standard 

 

В нижнем правом углу некоторых кнопок имеется малень-

кая черная стрелка. Если некоторое время удерживать на ней 

нажатой левую кнопку мыши, на экране появится меню с допол-

нительными элементами. На рисунке 3 показано меню Zoom 

(Масштабирование) панели инструментов Standard (Стандарт-

ная). 

 

                                  
 

Рисунок 3 – Меню Zoom (Масштабирование) панели  

инструментов Standard (Стандартная) 



11 

 

 

Панели инструментов могут быть закрепленными (в таком 

состоянии они отображаются по умолчанию) и плавающими. 

Название плавающей панели инструментов можно увидеть во 

всплывающей подсказке при наведении указателя мыши на па-

нель. Для закрытия плавающей панели инструментов предназна-

чена кнопка с крестиком, расположенная в правой части. Кнопки 

плавающей панели инструментов могут располагаться как в один 

ряд, так и в несколько. Чтобы сделать панель плавающей, доста-

точно перетащить ее с помощью мыши на некоторое расстояние 

от края графического экрана. На рисунке 4 показана плавающая 

панель инструментов Standard (Стандартная) с различным рас-

положением кнопок. 
 

 
 

Рисунок 4 – Плавающая панель инструментов Standard. 

 

Чтобы отобразить или скрыть панель инструментов, щелк-

ните на любой из них правой кнопкой мыши. На экране появится 

меню, содержащее список доступных панелей. Для отображе-

ния/скрытия любой из панелей выберите ее в меню. В нижней ча-

сти меню расположено подменю Lock Location (Место фикса-

ции), с помощью которого вы можете блокировать положение 

панелей инструментов и палитр. Так, например, чтобы отобра-

зить панель инструментов View (Вид) и блокировать ее, необхо-

димо выполнить следующие действия: 

1. Щелкните правой кнопкой мыши на любой панели ин-

струментов и в открывшемся меню выберите панель ин-

струментов View (Вид) (рис. 5). 
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Рисунок 5 – Поиск панели инструментов View (Вид) 

 

2. С помощью мыши перетащите панель инструментов, как 

показано на рисунке 6. 
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Рисунок 6 – Пример перемещения панели инструментов. 

 

3. Щелкнув правой кнопкой мыши на панели, откройте ме-

ню и выполните команду закрепления плавающих пане-

лей инструментов: Lock Location > Floating 

Toolbars/Panels (Место фиксации > Плавающие панели 

инструментов) (рис. 7). 

Панель будет блокирована, и вы не сможете перемещать ее 

по рабочему окну. Для отмены блокирования снова выполните 

эту же команду. 
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Рисунок 7 – закрепление панелей инструментов в поле меню 

 

По умолчанию в рабочей области программы AutoCAD  

отображены восемь наиболее часто используемых панелей ин-

струментов, присоединенных к верхней, левой и правой сторонам 

графического экрана программы, например 

• Stadard (Стандартная) (см. рис. 1.7) – содержит кнопки, 

предназначенные для вызова базовых команд, таких как со-

здание, открытие, сохранение файла, просмотр проекта пе-

ред печатью и вывод его на печать (Plot), операции с буфе-

ром обмена, отмена и возврат действий. Кроме того, здесь 

расположены команды вызова палитр программы. 

• Workspaces (Рабочие пространства) – служит для переклю-

чения между рабочими пространствами программы 

AutoCAD 2009: 2D Drafting & Annotation (Двухмерное 
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черчение и аннотирование), 3D Modeling (Трехмерное мо-

делирование) и AutoCAD Classic (Классический AutoCAD). 

• Tool Palettes (инструментальная палитра или панель рисо-

вания, присоединена к левой стороне графического экрана); 

• Modify (панель инструментов модификации или панель ре-

дактирования, присоединена к правой стороне графического 

экрана) 

 

3. Командная строка (рис. 8) расположена ниже графического 

экрана программы и позволяет пользователю вводить команды с 

клавиатуры. В ранних версиях она была основным инструментом 

диалога пользователя и программы, однако с выходом новых вер-

сий программы значение этого элемента все более уменьшается. 

Существенную роль в этом сыграло появление в AutoCAD 2006 

динамического ввода, позволяющего вводить команды в области 

рисования, рядом с графическим курсором. Кроме того, команд-

ная строка еще выполняет некоторые функции, оставаясь доста-

точно важным элементом интерфейса, и при работе вы периоди-

чески будете ее использовать. 

 

 
 

Рисунок 8 – Командная строка 

 

Независимо от способа ввода команда отображается в ко-

мандной строке. Здесь присутствуют все параметры команды, а 

также подсказки. После ввода команды в командной строке по-

явится запрос на действие с доступными параметрами команды. 

Вы можете задать параметры, запустить выполнение команды 

или прервать его, нажав клавишу Esc. 

Командная строка хранит историю введенных команд. Од-

нако поскольку область команд занимает две строки, просмотр 

истории затруднителен. Вы можете увеличить размер командной 

строки, но это уменьшит область графического экрана, что очень 

неудобно. Для решения данной проблемы в программе AutoCAD 

предусмотрено отображение области команд в отдельном окне. 
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Если вам нужно просмотреть историю команд, нажмите клавишу 

F2, и на экране появится окно AutoCAD Text Window (Текстовое 

окно AutoCAD) с необходимой информацией (рис. 9). Чтобы 

убрать его, нажмите еще раз клавишу F2. 

  

 
 

Рисунок 9 – окно AutoCAD Text Window (Текстовое окно 

AutoCAD) 

 

В самой нижней части рабочей области программы распо-

ложена строка состояния (вспомогательное меню) (рис. 10). 

 

 
 

Рисунок 10 – Строка состояния 

 

Она содержит текущие координаты курсора, а также кнопки 

включения/выключения режимов черчения. Коротко рассмотрим 

назначение кнопок. 
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 – Snap Mode (Шаговый режим) – включает/отключает 

режим привязки. Эту кнопку дублирует клавиша F9 на клавиату-

ре. 

 – Grid Display (Отображение сетки) – включа-

ет/отключает отображение на экране сетки. Нажатие этой кнопки 

равнозначно нажатию клавиши F7. 

 – Ortho Mode (Ортогональный режим) – включа-

ет/отключает ортогональный режим. При включенном данном 

режиме перемещение курсора ограничено горизонтальным и вер-

тикальным направлениями. Эту кнопку дублирует клавиша F8. 

 -Polar Tracking (Полярное отслеживание) – включа-

ет/выключает режим полярного отслеживания. Полярное отсле-

живание ограничивает перемещение курсора направлением под 

заданным углом, облегчая выбор точек, лежащих на воображае-

мых линиях под одним из заданных полярных углов. Нажатие 

этой кнопки соответствует нажатию клавиши F10. 

 – Object Snap (Объектная привязка) – позволяет выби-

рать различные точки объектов при работе с ними, облегчая по-

зиционирование графического курсора. Эту кнопку дублирует 

клавиша F3. 

 – Object Snap Tracking (Объектное отслеживание) – 

включает/выключает режим объектного отслеживания. Помогает 

вычерчивать объекты под определенными углами или в опреде-

ленных соотношениях с другими объектами. При включенных 

режимах автоотслеживания специальные временные линии помо-

гают выполнять точные построения. Нажатие этой кнопки равно-

значно нажатию клавиши F11. 

 – Allow/Disallow Dynamic UCS (Включить/выключить 

динамическую систему координат) – включает/отключает режим 

динамической системы координат. Динамическая система коор-

динат предназначена для работы с трехмерными объектами и 

позволяет временно выровнять плоскость XY по какой-либо име-

ющейся плоскости. 

 – Dynamic Input (Динамический ввод) – включа-

ет/отключает режим динамического ввода. Функция динамиче-

ского ввода позволяет вводить команды и выбирать их параметры 
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в области курсора, без использования командной строки. Когда 

динамический ввод включен, сведения, отображаемые в подсказ-

ках рядом с курсором, динамически обновляются по мере его пе-

ремещения. Когда команда активна, подсказки обеспечивают ме-

сто для ввода, осуществляемого пользователем. 

 – Show/Hide Lineweight (Показать/cкрыть толщину ли-

ний) – включает/выключает режим отображения линий в соот-

ветствии с их толщиной. 

 – Quick Properties (Краткие свойства) – включа-

ет/выключает отображение панели со свойствами выбранного 

объекта. 

 – Model or Paper space (Модель) – позволяет пере-

ключаться между пространствами модели и листа. 

 – Quick View Layouts (Быстрый просмотр слоев) – отоб-

ражает сразу все слои чертежа в отдельных окнах небольшого 

размера. 

 – Quick View Drawins (Быстрый просмотр чертежей) – 

включает/выключает просмотр чертежей. 

 – Pan (Панорамирование) – панорамирование рисунка. 

 – Zoom (Зумирование) – зумирование рисунка. 

 – SteeringWheel (Управление колесиком) – включает ин-

струмент Wheel (Колесико). 

 – ShowMotion (Показать движение) – включает инстру-

мент Motion (Движение). 

 – Workspace switching (Изменение рабочей области) – 

вызывает контекстное меню для выбора режима отображения ра-

бочей области. 

 – Кнопка для блокирования положения панелей инстру-

ментов и окон. 

 – Отображение кнопок включения/выключения режимов 

черчения в строке состояния устанавливается в контекстном ме-

ню (рис. 11) 
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Рисунок 11 – Контекстное меню настройки строки состоя-

ния 
 

 – Clean Screen (Очистка экрана) – очищает экран. При ее 

нажатии исчезают все панели инструментов, таким образом уве-

личивается область графического экрана. Эта функция полезна 

при работе на мониторах с маленькой диагональю. 

 

1.3 Создание рабочих слоёв и изменение их свойств 

 

Для работы со слоями в AutoCAD есть панель Диспетчер 

свойств слоев (Layers), находящаяся обычно над рабочим полем 

рисунок 12). Ее характерный признак – набор цветных значков, 

включающих лампочку, солнце, замок. Работа со слоями начина-

ется с создания набора слоев. Создание, настройка и удаление 

слоев производится в менеджере слоев (Layer Properties Manager), 

вызываемом самой левой кнопкой на панели слоев с изображени-

ем стопки листов бумаги или в меню Format>>Layer... Набирая 

названия слоев на русском языке, не следует использовать букву 

«б», она трактуется как запятая и приводит к созданию следую-

щего слоя. 
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Рисунок 12 – Панель Диспетчер свойств слоев (Слои) 

 

Слой «0» всегда существует в AutoCAD, слой Defpoints 

также создается AutoCAD, остальные слои – пользовательские, 

им желательно установить разные цвета (Color), а слою Стены 

установить толщину (вес – Lineweight) линий 0.7 мм. При удале-

нии слоев удаляемые слои только помечаются к удалению, окон-

чательное удаление производится кнопкой Apply. Завершать ра-

боту в менеджере следует кнопкой OK, иначе изменения не со-

хранятся. 

Значок принтера в поле Plot менеджера слоев может иметь 

серый вид, как например, слой Defpoints, такой слой на экране 

отображается, но на принтере – плоттере не печатается.  

Управление слоями производится на панели Слои (Layers) в 

списке слоев. Назначение слоя текущим выполняется выбором 

названия нужного слоя в списке по имени. В текущем слое будут 

произведены дальнейшие построения.  

Для переноса объектов между слоями надо сначала выбрать 

объект (или объекты), затем в списке слоев выбрать предназна-

ченный для них слой, затем нажать на клавиатуре клавишу Esc 

для снятия выбора с объектов. 

 
 

Рисунок 13 – Свойства слоев (панель диспетчера свойств слоев) 
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Для управления слоями служат три значка (рисунок 13):  

- Лампочка – включение / выключение слоя. Выключенный 

слой не отображается и не печатается, но может быть сделан те-

кущим, т.е. в нем можно что-либо начертить, не видя результата.  

- Солнце – замораживание / размораживание слоя. Заморо-

женный слой не отображается и не печатается и не может быть 

сделан текущим.  

- Замок – блокирование / разблокирование слоя. В заблоки-

рованном слое невозможно изменить и удалить объекты, но мож-

но чертить новые.  

Между солнцем и замком находится неактивная в простран-

стве модели кнопка замораживания на текущем листе, она ис-

пользуется для настройки печати и будет рассмотрена ниже. 

Цветной квадратик служит только для индикации цвета слоя и не 

может служить для изменения цвета. Для изменения необходимо 

вызывать менеджер слоев, как это было описано выше.  

Дополнительные возможности по управлению слоями зало-

жены в меню Format>>Layer Tools. Там есть возможность по 

быстрому изолированию слоя (выключению всех слоев, кроме 

одного) и включению сразу всех слоев. 

 

1.4 Создание файлов чертежей 

 

Все чертежи, созданные в программе AutoCAD, хранятся в 

файлах с расширением DWG. В таком файле хранится полная 

информация о чертеже: всевозможные стили, параметры, такие 

как единицы измерения, режимы черчения и т. д. По мере разви-

тия программы формат используемых файлов также  оставается 

неизменным, поэтому чертежи, созданные в более новых версиях 

AutoCAD, не могут быть открыты в более старых.  

Для создания нового файла можно применить один из двух 

способов: 

• без использования окна начала работы (этот способ наибо-

лее простой и применяется по умолчанию); 

• с заданием различных параметров в окне начала загрузки. 
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1.4.1 Создание нового документа без использования окна 

начала работы 

Для создания нового файла упрощенным способом необхо-

димо выполнить следующие действия. 

1. Кликнуть мышкой по кнопке New (Новый) на панели 

быстрого доступа или выполнить команду меню File > New 

(Файл > Новый). На экране отобразится диалоговое окно Select 

template (Выбор шаблона) (рисунок 14). Это окно похоже на 

стандартное окно выбора файлов операционной системы 

Windows и отображает содержимое каталога Template (Шаблон), 

принадлежащего директории, в которую была установлена про-

грамма AutoCAD. В данной папке находятся файлы с расширени-

ем DWT, которые представляют собой готовые шаблоны черте-

жей, обладающие некоторыми настройками и использующиеся 

как основа для создания документов.  

 

 
 

Рисунок 14 – Диалоговое окно Select template (Выбор шаблона) 
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2. Выделить нужный шаблон. При этом в области Preview 

(Образец), расположенной в правой части окна, появится изобра-

жение объектов, которые имеются в выбранном шаблоне. 

3. Выберите нужный шаблон и нажмите кнопку Open (От-

крыть). 

 

Примечание 
По умолчанию программа AutoCAD не содержит шаблонов, 

созданных по русским стандартам черчения, поэтому при необ-

ходимости следует самостоятельно добавить файлы нужных 

шаблонов в каталог Template (Шаблон). 

4. Если нет необходимости, чтобы в новом чертеже исполь-

зовался какой-либо шаблон, для этого нужно кликнуть левой кла-

вишей мыши маленькую кнопку со стрелкой, расположенную 

справа от кнопки Open (Открыть). В открывшемся меню (рис. 15) 

выбрать единицы измерения чертежа (метрические или британ-

ские), и на основе этого будет создан новый файл. Если выбрать в 

меню пункт Open (Открыть), файл будет создан на основе выде-

ленного в данный момент шаблона. 

 

 
 

Рисунок 15 – Создание чертежа без шаблона 

 

1.4.2 Создание нового документа с помощью окна начала 

работы 

Чтобы при создании нового файла использовалось окно 

начала работы, необходимо присвоить значение 1 системной пе-

ременной STARTUP. Для этого выполните следующие действия. 

1. Ввести в командную строку название переменной и 

нажмите клавишу Enter или Пробел. Появится запрос: 

Enter new value for STARTUP <0>: 
2. Ввести 1 и снова нажать клавишу Enter или Пробел. 

3. Щелкнуть на кнопке New (Новый) на панели быстрого 

доступа или выполнить команду меню File > New (Файл > Но-
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вый). На экране появится диалоговое окно Create New Drawing 

(Создание нового чертежа) (рисунок 16). 

 

    
 

Рисунок 16 – Диалоговое окно Create New Drawing  

(Создание нового чертежа) 

 

Рассмотрим основные элементы этого окна: 

– Первая кнопка Open a Drawing (Открытие чертежа) неак-

тивна. 

– Выйдите из программы AutoCAD и снова запустите ее. 

Теперь при щелчке на кнопке New (Новый) на панели быстрого 

доступа или при выполнении команды File > New (Файл > Но-

вый) будет открываться окно Startup (Запуск), в котором кнопка 

Open a Drawing (Открытие чертежа) будет активна (рисунок 17). 

При нажатии кнопки внутри окна отобразится область Select a 

File (Выберите файл), позволяющая выбрать созданный ранее 

файл и открыть его. Если нужный файл отсутствует в данной об-

ласти, вы можете нажать кнопку Browse (Обзор) и в открывшем-

ся окне Select File (Выбор файла) найти нужный файл. Это окно 

очень похоже на описанное выше окно Select template (Выбор 

шаблона). 
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Рисунок 17 – Открытие чертежа 

 

– Вторая кнопка – Start from Scratch (Простейший шаблон) 

(нажата на рисунке 16). С ее помощью создается чертеж, не отли-

чающийся от чертежа, созданного первым способом (без исполь-

зования окна начала работы) без выбора шаблона. 

– Следующая кнопка – Use a Template (По шаблону). Со-

здание чертежа идентично созданию нового файла без использо-

вания окна Startup (Запуск). Вы можете выбрать шаблон доку-

мента из имеющихся или отказаться от шаблонов. При нажатии 

кнопки Browse (Обзор) откроется диалоговое окно Select a 

template file (Выбор файла шаблона). 

– Последняя кнопка, Use a Wizard (Вызов мастера), вызыва-

ет мастер создания нового чертежа, с помощью которого вы сами 

можете настроить параметры нового документа. Мастер может 

работать в двух режимах: Quick Setup (Быстрая подготовка) и 

Advanced Setup (Детальная подготовка) – при выборе этого спо-

соба настраивается большее количество параметров. 

Создадим новый чертеж с помощью мастера детальной под-

готовки. 

1. В окне Startup (Запуск) нажмем кнопку Use a Wizard 

(Вызов мастера), в области Select a Wizard (Выберите мастер) 

выделим пункт Advanced Setup (Детальная подготовка) и 

нажмем кнопку OK (рисунок 18).  
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Рисунок 18 – Вызов мастера создания нового чертежа 

 

2. В первом окне мастера (рисунок 19) предлагается выбрать 

единицы измерения чертежа, а также, в раскрывающемся списке, 

точность значений (количество отображаемых после запятой зна-

ков). Настроив параметры, нажимаем кнопку Next (Далее). 

 

 
 

Рисунок 19 – Выбор единиц измерения 
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3. Следующее окно позволяет выбрать единицы измерения 

углов, а также точность значений углов. Снова вводим свои зна-

чения и нажимаем кнопку Next (Далее). 

4. Затем выбираем направление нулевого угла. Вы можете 

выбрать одно из направлений: East (Восток), North (Север), West 

(Запад), South (Юг) – или указать произвольное значение градуса 

начального угла. Отсчет при этом будет происходить от направ-

ления East (Восток). Выберем нужные значения и нажмем кноп-

ку Next (Далее). 

5. После этого необходимо установить направление отсчета 

углов: против часовой стрелки или в ее направлении. Делаем 

свой выбор и нажимаем кнопку Next (Далее). 

6. В последнем окне вы можете установить размер области, 

доступной для рисования. Вводим соответствующие параметры и 

нажимаем кнопку Finish (Готово). Чертеж создан. 

 

1.5 Сохранение и завершение работы 

 

Для сохранения документа нужно нажать кнопку Save (Со-

хранить) на панели быстрого доступа либо на панели инструмен-

тов Standard (Стандартная). Можно также выполнить команду 

меню File > Save (Файл > Сохранить). На экране появится диало-

говое окно Save Drawing As (Сохранение чертежа) (рисунок 20). 

В нем можно выбрать каталог для сохранения, название 

файла, а также его тип: DWG или DXF (тип файлов, который 

можно открыть в других приложениях, а не только в AutoCAD). 

При этом можно указать версию формата, то есть, например, со-

хранить чертеж в формате, совместимом с ранними версиями 

программы. 

Если вы хотите сохранить файл под другим названием, не-

обход щелкнуть по кнопке меню с буквой «А» в левом верхнем 

углу окна программы и выполните команду меню File > Save As 

(Файл > Сохранить как). На экране появится то же диалоговое 

окно Save Drawing As (Сохранение чертежа), в котором можно 

ввести нужное имя. При этом будет создана копия файла: то, что 

вы сделали до этого момента, будет сохранено в прежнем месте 

под прежним названием. 
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Рисунок 20 – Окно сохранения чертежа 

 

Чтобы закрыть чертеж, нужно кликнуть по кнопке меню с 

буквой «А» в левом верхнем углу окна программы и выполнить 

команду меню File > Close (Файл > Закрыть) либо нажать кнопку 

с крестиком в правом верхнем углу чертежа. Для завершения ра-

боты программы  необходимо нажать сочетание клавиш Ctrl+Q 

или щелкнуть по кнопке меню с буквой «А» и выполнить коман-

ду меню File > Exit (Файл > Выход). 

Можно также нажать кнопку с крестиком в правом верхнем 

углу программы. 

 

2. Практическая часть 

 

Изучив теоретические положения лабораторного занятия 

№ 1 можно приступить к выполнению практической части заня-

тия на ПК: 

1. Выполнить запуск графического редактора Autocad 

2. Ознакомиться с интерфейсом программы, научиться ви-

зуально ориентироваться по расположению панелей ин-

струментов на рабочем экране; 
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3. Настроить «своё» рабочее пространство и рабочие слои в 

соответствии с НТД, а именно создать слои по ГОСТ 

2.303 – 68 «Линии»: сплошную толстую, сплошную тон-

кую, штриховую, штрихпунктирную, и дополнительно 

«размерный» слой. Задать слоям цвет, вес и тип линии. 

4. На практике ознакомиться с командами  панелей черче-

ния (рисования) и модификации (редактирования), вспо-

могательного меню. 

5. Создать свой файл и сохранить его в папке «Мои доку-

менты» 

 

Вопросы для самоконтроля 

 

1. Как осуществить запуск программы Autocad? 

2. Интерфейс программы Autocad. 

3. Какие пункты меню вы знаете? 

4. Что такое панель инструментов, какие команды она 

включает. Какие бывают панели инструментов? 

5. Где расположена командная строка, её роль в графиче-

ском редакторе Autocad? 

6. Где расположена строка состояния и какие кнопки вклю-

чения/выключения режимов черчения содержит? 

7. Что такое рабочий слой и как его создать? 

8. Назовите свойства слоев. 

9. Назовите способы создания нового файла в программе 

Autocad. 

10. Как сохранить документ и завершить работу программы 

Autocad? 
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Лабораторное занятие № 2 

«Изучение инструментов черчения 

 

Цель занятия: 

- ознакомление студентов с панелью черчения (рисования): 

простыми и сложными примитивами, командой нанесения штри-

ховки, командами установки и редактирования текста; 

- закрепление теоретического материала посредством вы-

полнения графического задания по текущей теме на ПК.  

 

1. Теоретические положения 

 

Основные инструменты черчения вынесены на панель ин-

струментов Draw (Черчение), которая находится обычно слева от 

рабочего поля (рисунок 21). Большинство из инструментов име-

ют свои особенности выполнения. Для основных инструментов – 

это следующие особенности:  

 
Рисунок 21 – 

Панель черчения  

- Line (Линия) – в процессе черчения линий 

можно щелчком правой кнопки мыши вызы-

вать всплывающее меню, в котором выбирать 

следующие варианты продолжения черчения: 

Close (Замкнуть) – создать замкнутый контур, 

соединить окончание последовательности от-

резков с началом; Undo – отменять последние 

начерченные отрезки линий. 

- Construction Line (Линия конструкции) – 

бесконечная в обоих направления линия, ча-

сто используется в дизайнерском чертеже для 

создания набора осей. 

- Polyline (Полилиния) – многосегментная 

линия, позволяющая чередовать линейные и 

дугообразные участки.  

- Polygon – многоугольник, количество сторон 

устанавливается пользователем.  

- Rectangle – прямоугольник. 
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- Arc – дуга. Построение по трем точкам (начальная точка – 

промежуточная точка – конечная точка).  
- Circle – круг, строится по центру и радиусу.  

- Revision Cloud – облако, последовательность дуг.  

- Spline, сглаженная полилиния, полилиния с плавно скруг-

ленными углами.  

- Ellipse – эллипс по трем точкам.  

- Ellipse Arc – дуга эллипса.  

- Insert Block – вставка готового блока.  

- Make Block – построение блока (составной объект).  

- Point – точка (настройка вида точки Format>>Point Style).  

- Hatch – штриховка замкнутых областей.  

- Gradient – градиентная заливка цветом.  

- Region – область, начальный трехмерный элемент. 
- Table – таблица. 

- Text – нанесение текста. 
 

2. Практическая часть 

 

Изучив команды панели черчения, студенты с целью за-

крепления теоретического материала и получения практических 

навыков в графическом редакторе Autocad должны выполнить 

графическое задание  «Рамка для чертежа и основная надпись»: 

1. Вычертить лист формата А3 (контур листа) и рамку с ос-

новной надписью в соответствии с ГОСТ 2.303-68.  

2. Работа выполняется в настроенном рабочем пространстве 

(классический Autocad) и созданными рабочими слоями на 

предыдущем занятии.  

Пример графического задания по данной теме представлен 

на рисунке 22. 
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Рисунок 22 – Пример графического задания  

«Рамка для чертежа и основная надпись» 

 

3. Вопросы для самоконтроля 

 

1. Назовите основные инструменты черчения. 

2. Где расположена панель инструментов? 

3. Как настроить панель инструментов? 

4. Какой клавишей осуществляется отмена команды в про-

грамме Autocad? 

5. Какой клавишей осуществляется подтверждение команды в 

программе Autocad? 

6. Как построить линию? 

7. Как построить многоугольник, прямоугольник? 

8. Как построить дугу по 3-ём точкам? 

9. Как построить эллипс по 3-ём точкам? 

10. Как нанести штриховку на замкнутую область? 
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Лабораторное занятие № 3 

«Изучение панели модификации (редактирования). 

Команды «фаска» и «сопряжение» 

 

Цель занятия: 

- изучение студентами команд панели модификации (редак-

тирования), редактирование простых и сложных примитивов.  

- изучение способов построения фасок и сопряжений графи-

ческих примитивов; 

- выполнение графического задание по текущей теме и вы-

дача ДЗ №1 «Сопряжение». 
 

1. Теоретические положения 

 

1.1 Основные команды панели модификации 

 

 
 

Рисунок 23 –   

панель  

модификации 

Основные инструменты черчения вынесены на 

панель инструментов Modify (Модификация), ко-

торая находится обычно справа от рабочего поля.  

Erase – Удалить. Последовательность примене-

ния: нажать на кнопку, щелкнуть на линии уда-

ляемого объекта, нажать на Enter.  

Copy – Копировать, создает копии выбранного 

объекта, пока операция не будет завершена кла-

вишей Enter.  

Mirror – Зеркало. Создание зеркальной копии 

выбранного объекта.  

Offset – Смещение. Создание параллельных ли-

ний и контуров.  

Array – Массив (прямоугольный – Rectangular 

или круговой – Polar). Создание множественных 

копий.  

Move – Перемещение.  

Rotate – Поворот.  

Scale – Масштабирование, пропорциональное 

изменение размеров.  

Stretch – Растягивание, изменение размера по од-
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ной из осей.  

Trim – Отрезать. Отрезание участков пересекае-

мых линий.  

Extend – Удлинить. Удлинение линии до ближайшей границы. 

Break at Point (Break) – Разорвать в точке, делит линию на две, 

не создавая видимого разрыва.  

Join – Соединить, соединить линии, находящиеся на одной пря-

мой, в одну линию.  

Chamfer – Фаска, срезание углов с заданным через щелчок пра-

вой кнопки мыши параметром Distance. 

Fillet – Скругление углов с заданным через щелчок правой кноп-

ки мыши радиусом.  

Explode – Взорвать, разъединить объекты на составляющие эле-

менты (линии и дуги).  

 

1.2 Команда «Фаска»  

 

Команды "фаска" ("chamfer")  и "сопряжение" ("fillet") очень 

востребованы при выполнении графических изображений  в раз-

личных сферах деятельности. 

Для снятия фасок, например, с прямоугольника (рис. 24) вы-

зываем команду "фаска" и действуем по подсказкам командной 

строки. Вводим в командную строку букву "Д" (Заглавная буква 

слова "Длина" из подсказки)(рис. 25, а). Программа предлагает 

указать величину длины, то есть величину укорочения первой 

стороны (рис. 25, б), затем величину укорочения второй стороны. 

Можно эти величины указывать неравными, тогда и фаска будет 

скошенной (рис. 25, в). После этого остаётся мышкой указать по-

следовательно две соседние стороны прямоугольника (рис. 25, г). 

 

       
 

Рисунок 24 – Снятие фасок с прямоугольника 



35 

 

а) 

 
 

б) 

 
 

в) 

 
 

г) 

 
 

 
 

Рисунок 25 – Порядок выполнения снятия фасок 

 с прямоугольника 
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1.3 Команда «Сопряжение» 

 

Команда "сопряжение" не сложнее команды "фаска" 

(рис. 26) Чаще всего сопряжение проводят по указанному радиу-

су. Например, построим сопряжение смежных сторон прямо-

угольника (рис. 28).  

 
 

Рисунок 26 – Команда «Сопряжение» 

а) 

 
 

б) 

 
 

в) 

 
 

г) 

 
Рисунок 27 – Порядок выполнения команды «Сопряжение» 
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Если длины отрезков (длины сторон прямоугольника) не 

хватит, чтобы правильно скруглить угол, программа выдаст со-

общение (рис. 28): 

 

         
 

Рисунок 28 – Сообщение о неверности  

построения сопряжения 

 

2. Практическая часть 

 

Изучив команды панели модификации (редактирования), 

рассмотрим на конкретном  примере порядок выполнения графи-

ческой работы № 2 «Сопряжение». В рабочем пространстве мо-

дели в графическом редакторе Autocad необходимо вычертить 

деталь, построить сопряжения (рис. 29). 

 

                      
 

Рисунок 29 – Пример графической работы № 2  

«Сопряжение» 

 

 12 
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Для закрепления данной темы необходимо выполнить ДЗ 

№1 «Сопряжение», варианты заданий и описание домашнего за-

дания представлены в методических указаниях для самостоя-

тельной работы «Компьютерная графика» для студентов специ-

альности «Горное дело», образовательные программы «Открытые 

горные работы»; «Технологическая безопасность и горноспаса-

тельное дело».   

 

3. Вопросы для самоконтроля 
 

1. Где расположена панель редактирования? 

2. Как настроить панель редактирования? 

3. Назовите основные инструменты редактирования. 

4. Как повернуть изображение? 

5. Как переместить изображение? 

6. Как сделать изображение зеркальным? 

7. Как удлинить и обрезать линию до указанной линии? 

8. Как осуществить разрыв линии, окружности? 

9. Как построить сопряжение? 

10. Как построить фаску? 
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Лабораторное занятие № 4 

«Изучение панели модификации (редактирования).  

Создание массива объектов» 

 

Цель занятия: 

 - изучение команды «создание массива», способов создания; 

 - выполнение графического задания по текущей теме выдача 

ДЗ №2 «Создание массива» 

 

1. Теоретические положения 

 

Массивом называют множество однородных предметов, об-

разующих единое целое. Массивы программы AutoCAD – это со-

вокупность копий одного объекта, расположенных на равном 

расстоянии друг от друга. Так как массивы связаны со смещени-

ем координат, они могут быть прямоугольными и полярными. В 

прямоугольных массивах объекты смещаются по осям координат, 

и такие массивы представляют собой прямоугольные структуры. 

В полярных массивах копирование происходит вокруг одной 

точки, в результате чего такие совокупности имеют форму 

окружности. 

Для создания массива используется команда ARRAY. Ее 

можно вызвать, нажав одноименную кнопку  на вкладке Home 

(Основная) в группе Modify (Редактирование) ленты или на па-

нели инструментов Modify (Редактирование). Можно также вос-

пользоваться командой меню Modify > Array (Редактирование > 

Массив) или ввести ARRAY в командную строку. 

После запуска команды появится диалоговое окно Array 

(Массив) (рис. 30). 

 

Работа с командой «МАССИВ» в окне диалога (рис. 30): 

 

• Rectangular Array устанавливает прямоугольный массив.  

• Polar Array устанавливает круговой (полярный) массив.  

• Кнопка Select Object позволяет перейти в режим указания 

объектов, массив из которых необходимо создать.  
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• Информационное поле отображает вид создаваемого масси-

ва.  

В зависимости от выбора пользователя Rectangular Array 

или Polar Array состав параметров массива изменяется. 

 

 
 

Рисунок 30 – Диалоговое окно Array (Массив) 

 

Параметры прямоугольного массива (рис. 30): 

• Поле Rows – число строк прямоугольного массива.  

• Поле Columns – число столбцов прямоугольного массива.  

• Поле Row offset – задание расстояния между строками мас-

сива.  

• Поле Column offset – задание расстояния между столбцами 

массива.  

• Поле Angle of array служит для задания угла наклона осей, 

вдоль которых строится массив. 

• Кнопка Pick Both Offsets позволяет задать расстояния меж-

ду строками и столбцами массива, указав на графическом 

экране две произвольные точки. При этом расстояние между 

строками равно разности координат указанных точек вдоль 
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оси X, а расстояние между столбцами равно разности коор-

динат указанных точек вдоль оси Y.  

• Кнопка Pick Row Offset позволяет задать расстояние между 

строками массива, указав на графическом экране две произ-

вольные точки.  

• Кнопка Pick Column Offset позволяет задать расстояние 

между столбцами массива, указав на графическом экране 

две произвольные точки.  

• Кнопка Pick Angle of Array позволяет задать угол наклона 

осей массива, указав на графическом экране две произволь-

ные точки.  

 

Параметры полярного (кругового) массива (рис. 31): 

 
 

Рисунок 31 – Параметры полярного (кругового) массива 

 

• Поля Center point X:, Y: служат для задания координат цен-

тра массива.  

• Кнопка Pick Center Point позволяет задать центр массива, 

указав на графическом экране произвольную точку;  
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• Раскрывающийся список Method позволяет выбрать режим 

создания полярного массива:  

 Total number of items & Angle to fill — создание массива 

с определенным числом элементов, равномерно рас-

пределенных в пределах заданного угла;  

 Total number of items & Angle between items — создание 

массива с определенным числом элементов и заданным 

угловым шагом;  

 Angle to fill & Angle between items — создание массива 

элементов, расположенных в пределах определенного 

угла с заданным угловым шагом.  

• Поле Total number of items служит для задания общего 

числа элементов массива.  

• Поле Angle to fill служит для задания угла, в пределах кото-

рого размещаются элементы массива.  

• Поле Angle between items служит для задания углового ша-

га между элементами массива.  

• Флажок Rotate items as copied разрешает режим, при кото-

ром объекты создаваемого массива поворачиваются на со-

ответствующий угол;  

• Кнопка More открывает дополнительную панель Object base 

point, позволяющую задать положение базовой точки объек-

та (точки, расстояние до которой от центра массива остается 

постоянным).  

• Панель Object base point содержит следующие компоненты.  

• Флажок Set to object's default разрешает использовать ре-

жим определения базовой точки, принятой для данного объ-

екта по умолчанию:  

 точка центра для окружностей и эллипсов;  

 первый угол для многоугольников и прямоугольников;  

 начальная точка для линий, полилиний, сплайнов и лу-

чей;  

 точка вставки для блоков и текста;  

 средняя точка для конструкционных линий.  

• Поля ввода Base point X:, Y: служат для задания координат 

базовой точки объекта, которая отличается от принятой по 

умолчанию.  
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• Кнопка Pick Base Point позволяет задать базовую точку 

объекта, указав на графическом экране произвольную точку.  

 

2. Практическая часть 

     

Изучив команду «массив» и ее параметры, можно присту-

пать к выполнению графического задания по данной теме, а 

именно, в рабочем пространстве модели графического редактора 

Autocad вычертить деталь, используя параметры команды «Мас-

сив» (рис. 32, а,б). 

 

 

 
а) 

  

б) 

Рисунок 32 (а, б)– Пример графического задания по текущей теме 

 

Для закрепления данной темы необходимо выполнить ДЗ 

№2 «Создание массива», варианты заданий и описание домашне-

го задания представлены в методических указаниях для самосто-
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ятельной работы «Компьютерная графика» для студентов специ-

альности «Горное дело», образовательные программы «Открытые 

горные работы»; «Технологическая безопасность и горноспаса-

тельное дело».   

 

3. Вопросы для самоконтроля 
 

1. Что такое массив? 

2. Как называется команда, используемая для создания 

массива? 

3. Какие массивы бывают? 

4. Назовите параметры прямоугольного массива. 

5. Назовите параметры полярного (кругового) массива. 
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Лабораторное занятие № 5 

«Текстовые стили» 

 

 Цель занятия: 

 - ознакомление с настройкой текстовых параметров, тексто-

вых стилей; 

 - научиться настраивать текстовые стили и редактировать 

текст; 

 - выполнение графического задания  «Текстовые стили в 

AutoCAD» 

 

1. Теоретические положения 

1.1 Текстовый стиль 

 

Для работы с текстом в графическом редакторе AutoCAD 

есть панель инструментов Text (рис. 33). 

 

 
 

Рисунок 33 – Панель инструментов Text 

 

Работа с текстом начинается с организации текстовых сти-

лей. 

Текстовый стиль – это именованная совокупность значе-

ний параметров, которые определяют общие стилевые особенно-

сти и отличительные детали рисунка символов. Текстовые стили 

можно создавать, модифицировать, удалять, переименовывать и 

переносить на другой чертеж. 
 

• У текстовых объектов не должно быть персональных 

свойств форматирования. Текстовые объекты должны 
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наследовать свойства форматирования от своего текстового 

стиля.  

• Текстовых стилей в технической документации должно 

быть небольшое (2-3 стиля) количество (из соображений 

технической эстетики и удобства адаптации к международ-

ным стандартам).  

• НЕ РЕКОМЕНДУЕТСЯ использовать стандартный стиль 

«Standard» для своих текстовых объектов. НЕ РЕКОМЕН-

ДУЕТСЯ изменять настройки и свойства этого стиля.  

 

1.2 Организация текстовых стилей 

 

В главном меню графического редактора Autocad есть 

вкладка со значком « » – «Текстовые стили». Нажав на нее, 

открывается диалоговое окно Text Style (рис. 34). 

 

 
Рисунок 34 – Диалоговое окно настройки текстовых стилей 

 

Для создания нового текстового стиля необходимо: 

 Задать новый стиль с оригинальным именем.  

 Задать желаемые характеристики текста: шрифт, угол 

наклона (высоту и сужение лучше не изменять, т.к. потом 

можно их задать при желании любые).  
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 Если установить конкретную (отличную от нуля) высоту 

букв текста, то размер текстовых фрагментов будет ей ра-

вен.  

 Если оставить высоту букв, равную «нулю», то в процессе 

создания текста будет возникать вопрос о высоте, и высоту 

можно будет назначить любую (данный вариант рациональ-

нее).  

 Применить Apply и выйти из окна Cancel.  
 

Текст не является частью геометрической модели изделия и 

наносится в пространстве листа на пространство листа. Текст за-

носится на слой для текста.  

 

1.3 Многострочный текст « » (мультитекст) 
 

• Команда вызывает текстовый редактор с возможностями 

форматирования, вставки некоторых особенных символов, 

выравнивания строк и т.п.  

• Многострочный текст представляет собой единый целый 

объект.  

• Команда многострочного текста применяется для больших 

объемов текста. Удобна для использования ранее созданных 

текстовых файлов. Удобна для вставки форматированных 

текстовых фрагментов из буфера обмена. Рационально ее 

применение для заголовков плакатов.  

 

1.4 Однострочный текст « » 
 

• Команда создания НЕСКОЛЬКИХ СТРОК текста. Но при 

этом каждая строка будет самостоятельным объектом и не 

зависима от других.  

• Текстовые объекты подхватывают свойства текущего тек-

стового стиля.  

• Команда применяется для недлинных надписей штампа, 

технических требований, коротких пояснений и подписей на 
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чертеже (ВНИМАНИЕ! Не рационально применять мульти-

текст для таких записей.  

• Использование специальных символов в однострочном 

тексте осуществляется с помощью управляющих кодов, напри-

мер:  

 %%d — размещает в соответствующей позиции стро-

ки текста символ «градус»;  

 %%р — размещает в соответствующей позиции стро-

ки текста символ «плюс-минус»;  

 %%с — размещает в соответствующей позиции стро-

ки текста символ «диаметр окружности».  

 

1.5 Шрифты 
 

• Не желательно использование экзотических шрифтов (про-

блемы с кириллицей).  

• Использование дополнительно установленных шрифтов 

ГОСТ может вызвать проблему при открытии документа на 

другом компьютере. 

• Рационально применение шрифтов, которые корректно 

отображают кириллицу и имеются в любых стандартных 

версиях Autocad (Txt, Arial).  

• Не желательно использование гарнитуры Times.  

• Хороший эффект дает применение шрифта стандарта ISO 

(ISOCPEUR).  

• Для наклонности можно задать угол наклона от вертикали 

15 °.  

• Для правильного отображения шрифтов они должны быть 

установлены в системе.  

 

Шрифты формата *.shx  

- перед запуском Автокада надо скопировать в каталог уста-

новленного AutoCad в папку со шрифтами, примерно по пути 

C:\Program Files\AutoCAD 2006\Fonts 
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Шрифты формата *.ttf  

- надо скопировать в каталог установленного Windows в 

папку со шрифтами, примерно по пути C:\WINNT\Fonts 

 

2. Практическая часть 

     

Изучив настройку размерных стилей, их параметры, необ-

ходимо выполнить графическое задание  «Текстовые стили в Au-

toCAD»: 
 

1. Создать несколько (2-3 кроме стандартного) текстовых 

стилей с использованием разных шрифтов.  

2. Однострочным текстом создать фрагмент текста из трех 

строчек.  

3. Копировать фрагменты несколько раз.  

4. Присвоить фрагментам разный стиль.  

 

Пример графической работы № 3 представлен на рисунке 

35. 

 
 

Рисунок 35 – Пример графической работы № 3 

«Текстовые стили в AutoCAD» 
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3. Вопросы для самоконтроля 

 

1. Что такое текстовый стиль? 

2. Где расположена вкладка «Текстовые стили»? 

3. Назовите основные требования при создании текстовых 

стилей. 

4. Расскажите алгоритм создания нового текстового стиля. 

5. Функция команды «Многострочный текст». 

6. Функция команды «Однострочный текст». 

7. Какой шрифт используют для оформления графических до-

кументов в AutoCAD? 
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Лабораторное занятие № 6 

«Размерные стили» 

 

Цель занятия: 

- ознакомление с настройкой размерных параметров, раз-

мерных стилей;   

- научиться настраивать размерные стили; проставлять раз-

меры диаметров и радиусов окружностей, размеров фаски; редак-

тировать размеры; изменять параметры размеров и размерного 

текста; изменение положение размера; 

- нанесение размеров в домашних заданиях ДЗ №1 «Сопря-

жение» и № 2 «Создание массива»  

 

1. Теоретические положения 

1.1 Нанесение размеров 

 

Нанесение размеров и управление ими производится через 

раздел меню Dimension (рис. 36).  

 
Рисунок 36 – 

Нанесение размеров  

Dimension 

   Основные используемые размеры – 

это:  

   Linear (линейный) – размер паралле-

лен одной из осей координат.  

   Aligned (выровненный) – размер па-

раллелен измеряемому участку.  

   Arc Length (длина дуги).  

   Radius и Diameter для измерения ра-

диусов и диаметров кругов и дуг.  

   Angular (угловой) – для измерения 

углов.  

   Continue (продолжение) – нанесение 

цепочки размеров.  

   Leader – выносной текст, выноска.  
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Наиболее часто применяемые размеры, Linear и Aligned, 

проставляются тремя щелчками мыши (начальная точка измере-

ния, конечная точка измеряемого участка, положение размерной 

линии).  

Цепочка размеров (Continue) начинается с первого, самого 

короткого, типа Linear или Aligned (рис. 37). 

  
 

Рисунок 37 – Размерная цепочка 

 

Есть возможность изменить значение размерного текста уже 

нанесенного размера. Для этого надо сделать двойной щелчок ле-

вой кнопки мыши на нанесенном размере и в открывшемся окне 

свойств размера в разделе Text заполнить последнее поле (Text 

override). Занесенное в это поле значение будет отображаться в 

качестве размерного текста. 

 

1.2 Создание и настройка размерного стиля 

 

Стиль размера – это совокупность параметров, хранящихся 

под определенным именем и применяющихся к размерам в каче-

стве настроек. Стили размера управляют видом и поведением 

размерного объекта: используемой стрелки-указателя, стиля тек-

ста, допустимых значений и форматирования, а также общего 

масштаба размера. 

Стили размера функционируют подобно стилям текста или 

слоя: устанавливается определенный стиль текущим, и любые 

новые объекты создаются с использованием настроек, содержа-

щихся в этом стиле. Размерными стилями управляют с помощью 

команды DIMSTYLE. 

Когда запускают команду DIMSTYLE, открывается диало-

говое окно Dimension Style Manager (Менеджер стиля размера) 
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(рис. 38). В этом окне можно создать и изменить размерный 

стиль. 

 

 
 

Рисунок 38 – Окно менеджера стиля размера 
 

В поле Styles (Стили) отображаются стили размеров. Рас-

крывающийся список List (Список) позволяет указать, какие сти-

ли следует показывать в поле Styles (Стили). Можно выбрать 

отображение всех стилей или только использующихся в рисунке. 

Кроме того, с помощью флажка Don't list styles in Xrefs (Не 

перечислять стили в Xref) можно выбрать, показывать или скры-

вать стили размеров, содержащиеся во внешних ссылках (Xref). 

В области Preview of (Предварительный просмотр) отобра-

жается пример использования выбранного в данный момент сти-

ля размера. Кнопки, расположенные в правой части окна, позво-

ляют создавать, изменять, отменять и сравнивать стили размеров. 

 

AutoCAD поставляется с предопределенным стилем разме-

ра, заданным по умолчанию– ISO-25. Его можно изменить, пере-

именовать и даже удалить, если он не указан текущим. Парамет-

ры стиля ISO-25 определены в файле шаблона, используемого 

для создания рисунка. 
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Чтобы создать новый стиль размера, необходимо щелкнуть 

на кнопку New (Новый) в диалоговом окне Dimension Style 

Manager (Менеджер стиля размера). В результате появится окно 

Create New Dimension Style (Создать новый стиль размера) 

(рис. 39). 

 

 
 

Рисунок 39 – Диалоговое окно создания нового стиля размера 

 

Когда создается новый стиль размера, AutoCAD делает ко-

пию существующего стиля в качестве отправной точки. В окне 

Create New Dimension Style (Создать новый стиль размера) сле-

дует задавать имя для нового стиля размера и указывать, какой 

стиль нужно скопировать для использования в качестве основы. 

Можно также создать стиль, который будет применяться только к 

размерам определенного типа. Например, может понадобиться, 

чтобы все текстовые значения размеров выравнивались по раз-

мерным линиям, однако текстовые значения размеров радиуса и 

диаметра размещались горизонтально. В подобных случаях ис-

пользуются так называемые дочерние стили, которые возникают 

как подстили основного размерного стиля. 

 

Если в диалоговом окне Create New Dimension Style (Со-

здать новый стиль размера) выбрать дочерний стиль разме-

ра, в окне Dimension Style Manager (Менеджер стиля размера) 

в области Preview of (Предварительный просмотр) отобразят-

ся только те параметры размерного стиля, которые отлича-
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ются от родительского. В области Description (Описание) при 

этом приводятся различия между родительским и дочерним 

стилями. 

 

Для примера создадим новый стиль размера и применим его 

к чертежу, представленному на рисунке 40. 

 

 
 

Рисунок 40 – Исходный чертеж 

 

Для этого необходимо: 

1. Запустить команду DDIM. Появится диалоговое окно 

Dimension Style Manager (Менеджер стиля размера). Кликнуть 

по кнопке New (Новый), чтобы открылось окно Create New 

Dimension Style (Создать новый стиль размера). 

2. Ввести название Mech в поле New Style Name (Имя ново-

го стиля) и убедиться, что в списке Start With (Начать с) выбран 

стиль ISO-25, а в списке Use for (Использовать для) – значение 

All dimensions (Все размеры). Нажмите кнопку Continue (Про-

должить). На экране появится окно New Dimension Style (Новый 

стиль размера). 

3. Изменить, например, на вкладке Text (Текст) положение 

переключателя Text align ment (Выравнивание текста) на 

Horizontal (Горизонтально). 
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4. Кликнуть по кнопке OK, чтобы принять изменение 

настроек. Снова появится окно Dimension Style Manager (Мене-

джер стиля размера). Новый стиль размера отобразится в поле 

Styles (Стили). 

5. Кликнуть на кнопку Close (Закрыть), чтобы закончить 

выполнение команды DIMSTYLE. 

6. Разместить линейные размеры. Чертеж при этом должен 

выглядеть примерно так, как показано на рисунке 41. 

 

 
 

Рисунок 41 – Результат применения нового стиля размера 

 

Чтобы изменить параметры стиля размера, нужно выбрать 

его имя в окне Dimension Style Manager (Менеджер стиля разме-

ра) и кликнуть на кнопку Modify (Изменить). Откроется окно 

Modify Dimension Style (Изменить стиль размера), содержащее 

семь вкладок, на которых расположены настройки для различных 

аспектов размеров. 

 Параметры линий 
Вкладка Lines (Линии) предназначена для управления раз-

мерными и выносными линиями (рис. 42). 
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Рисунок 42 – Параметры размерных линий 

 

Область Dimension lines (Линии размера) позволяет уста-

навливать цвет (Color), тип (Linetype) и толщину (Lineweight) 

размерных линий, а также интервал между ними, использующий-

ся при создании базовых размеров. Поле Extend beyond ticks 

(Выход за пределы меток) доступно только тогда, когда указаны 

определенные типы стрелок-указателей. Например, если исполь-

зуется архитектурная метка, параметр Extend beyond ticks (Вы-

ход за пределы меток) указывает, насколько линия размера будет 

продлена за пределы меток. Можно  также сделать невидимой 

размерную линию с любой стороны от текстового значения (для 

этого предназначены флажки Dim line 1 и Dim line 2). Это удоб-

но при проставлении размеров в загроможденных областях, где 

линии часто вытесняют текстовое значение размера. 

Область Extension lines (Выносные линии) содержит подоб-

ные параметры для выносных линий. Можно задать цвет, тип и 

толщину выносных линий, настроить их длину и указать проме-

жуток между выносной линией и объектом, для которого про-

ставляется размер. 
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 Настройки символов и стрелок 
Вкладка Symbols and Arrows (Символы и стрелки) позволяет 

устанавливать размер и тип используемых стрелок-указателей 

(рис. 43). 

Является возможным устанавливать различные стрелки-

указатели для первой и второй размерных линий, а также отдель-

ную стрелку для указательных линий (Leader). Область Center 

marks (Центральные метки) предназначена для определения раз-

мера и типа центральных меток. Здесь можно указывать, как бу-

дут отображаться центральные метки в размерах радиуса и диа-

метра, а также настраивать создание линий центральных меток 

командой DIMCENTER. 

Можно также разорвать размер или выносные линии в месте 

пересечения с геометрическими объектами или другими разме-

рами. Хотя это не является рекомендуемой чертежной практикой, 

иногда такие разрывы бывают необходимы, поэтому в области 

Dimension Break (Разрыв размера) присутствует возможность за-

дать величину такого разрыва. 

Параметры в области Arc length symbol (Символ длины ду-

ги) отвечают за место отображения символа длины дуги при ис-

пользовании команды DIMARC. В поле Jog angle (Угол зигзага) 

указывают угол зигзагообразного участка линии, используемого 

при выполнении команды DIMJOGGED. 

 Настройки текста 
Вкладка Text (Текст) управляет размещением и видом тек-

ста (рис. 44). В области Text appearance (Вид текста) можно 

устанавливать используемый стиль текста. Нажатие кнопки с 

многоточием приводит к появлению диалогового окна Text Style 

(Стиль текста), в котором можно создавать и изменять стили тек-

ста. Кроме того, на данной вкладке можно настроить цвет и фон 

текста, а также задать отображение рамки вокруг текста, устано-

вив флажок Draw frame around text (Рисовать рамку вокруг тек-

ста). 

В области Text placement (Размещение текста) можно за-

дать размещение текста относительно размерных и выносных ли-

ний. В раскрывающемся списке Vertical (Вертикально) можно 

выбрать положение текстового значения относительно размерной 
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линии: выше, ниже или по центру. Если вы выберете значение 

JIS, текстовый размер будет расположен в соответствии с япон-

ским индустриальным стандартом. Список Horizontal (Горизон-

тально) задает размещение текста относительно выносных линий: 

вы можете разместить текст возле первых или вторых выносных 

линий либо протянуть его поверх какой-либо выносной линии. 

Из списка View Direction (Направление просмотра) можно вы-

брать направление текста: слева направо или справа налево. В 

поле Offset from dim line (Смещение от линии размера) задают 

промежуток между линией и текстовым значением размера. 

 

 
 

Рисунок 43 – Параметры символов и стрелок 
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Рисунок 44 – Параметры текста 

 

 Параметры подгонки и масштаба 
Вкладка Fit (Подгонка) управляет поведением и масштабом 

размеров (рис. 45). Здесь можно указать, что будет происходить с 

размерами, если AutoCAD не может разместить одновременно 

размерные линии и текстовое значение между выносными лини-

ями. 
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Рисунок 45 – Параметры подгонки и масштаба размеров 

 

С помощью настроек, расположенных в области Text 

placement (Размещение текста), можно определить, где будет 

размещаться текст, если он не находится в заданном по умолча-

нию положении. 

Например, если чертеж нужно печатать в масштабе 1/8"=1'–

0", вы должны масштабировать все аннотации вашего чертежа с 

коэффициентом 96. Поскольку рисунок сокращен для печати, это 

гарантирует, что аннотация будет правильного размера. Пере-

ключатель Scale for dimension features (Масштаб для свойств 

размера) управляет общим масштабом аннотаций объектов раз-

мера. 

 

Важно отметить, что параметр Scale for dimension 

features (Масштаб для свойств размера) влияет только на 

размер самих размерных объектов (линий, текста), а не на 

значения размеров. 
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Use overall scale of (Использовать общий масштаб) – это 

масштабный коэффициент, который применяется ко всем свой-

ствам размера. Например, если текстовые значения и стрелки-

указатели имеют высоту 0.125, а значение общего масштаба – 2, 

AutoCAD будет отображать текст и стрелки-указатели в масшта-

бе 0.25. 

Общий масштаб (положение переключателя Use overall 

scale of (Использовать полный масштаб)) чаще всего использует-

ся, когда размеры помещаются в пространство моделирования 

(область рисования) и вы выводите в этом пространстве вид чер-

тежа. Если же вы выводите чертеж из пространства макета (ли-

ста), то можете установить переключатель в положение Scale 

dimensions to layout (Масштабировать размеры для макета). В 

этом случае AutoCAD автоматически масштабирует все свойства 

размеров в соответствии с масштабом области просмотра макета. 

Это полезно, когда один рисунок содержит множество видов и 

графических масштабов. 

В области Fine tuning (Тонкая настройка) можно задать не-

которые дополнительные параметры вида размера. Если установ-

лен флажок Place text manually (Помещать текст вручную), при 

создании размеров появляется дополнительная подсказка, что 

позволяет вам определять местоположение текстового значения 

размера после того, как вы определите местонахождение размер-

ной линии. 

Установленный флажок Draw dim line between ext lines 

(Рисовать линию размера между выносными линиями) вынудит 

размерную линию разместиться между выносными линиями 

независимо от местоположения текстового значения. 

 

 Определение основных единиц 
Параметры вкладки Primary Units (Основные единицы) 

предназначены для форматирования текстового значения размера 

(рис. 46). В области Linear dimensions (Линейные размеры) мож-

но указать, как будут отображаться единицы измерения, а в обла-

сти Angular dimensions (Угловые размеры) – как будут выгля-

деть угловые размеры. 
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Рисунок 46 – Параметры форматирования  

текстового значения размера 

 

Параметр Unit format (Формат единиц) устанавливает фор-

мат единиц измерения для размеров всех типов, кроме угловых. 

Обычно его настраивают для согласования единиц измерения ри-

сунка. В дополнение к стандартным настройкам можно также 

выбрать единицы Рабочего стола Windows, которые используют 

параметры, расположенные в окне Язык и региональные стан-

дарты (рис. 47). 
Это окно можно вызвать, выполнив команду Пуск > Па-

нель управления и щелкнув в открывшемся окне на значке 

Язык и региональные стандарты. 
С помощью списка Units format (Формат единиц) в области 

Angular dimensions (Угловые размеры) можно управлять отоб-

ражением угловых размеров: Decimal Degrees (Десятичные гра-
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дусы), Degrees Minutes Seconds (Градусы, минуты, секунды), 

Gradians (Грады) или Radians (Радианы). 

 

 
 

Рисунок 47 – Окно настройки региональных параметров Windows 
 

Параметр Precision (Точность) контролирует количество де-

сятичных разрядов в тексте размера. Он влияет только на отоб-

ражение текстового значения, не изменяя геометрию рисунка и 

не затрагивая фактическое измеренное значение размера. 

В раскрывающемся списке Fraction format (Формат дроби) 

можно выбрать вариант отображения дробей. Эта настройка до-

ступна, только когда в списке Unit format (Формат единиц) вы-

бран пункт Architectural (Архитектурный) или Fractional (Дроб-

ный). Данный параметр используется в сочетании с Fractional 

height scale (Масштаб высоты дроби) на вкладке Text (Текст). 
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Если в списке Unit format (Формат единиц) выбрано значе-

ние Decimal (Десятичный), то в раскрывающемся списке Decimal 

separator (Десятичный разделитель) можно установить символ, 

используемый в качестве десятичного разделителя. 

В поле Round off (Округление) задают правило округления 

для размеров всех типов, кроме углового. Если вы введете 0.25, 

все расстояния округлятся к самому близкому значению 0.25 от 

единицы измерения. Если вы введете 1.0, все измеренные рассто-

яния округлятся к самому близкому целому числу. Количество 

цифр, отображаемых после десятичной точки, зависит от значе-

ния параметра Precision (Точность). 

В поле Prefix (Префикс) можно задать префикс для тексто-

вого значения размера. Указанный текст будет помещаться перед 

заданным по умолчанию значением. Вы можете ввести в данное 

поле любой текст или использовать управляющие коды, чтобы 

отобразить специальные символы. Например, управляющий код 

%%C отвечает за отображение символа диаметра. 

В поле Suffix (Суффикс) также можно задать дополнитель-

ный текст, однако в этом случае он будет помещаться после за-

данного по умолчанию значения. Например, можно ввести сим-

вол дюйма ("), и программа будет вставлять его после каждого 

значения размера. 

Область Measurement scale (Масштаб измерений) содержит 

параметры, позволяющие определить коэффициент масштаба для 

значений размера, заданных по умолчанию. Параметр Scale 

factor (Коэффициент масштаба) определяет коэффициент мас-

штаба для измерений линейных размеров. Значение любого ли-

нейного размера умножается на этот коэффициент, и окончатель-

ное значение используется как заданный по умолчанию текст. 

Например, если вы установите коэффициент масштаба размера 

равным 2, то текстовое значение размера для линии в 1 дюйм бу-

дет отображается как 2 дюйма. Значение не применяется к угло-

вым измерениям и к округлению, а также к положительным или 

отрицательным допускам. 

Если установлен флажок Apply to layout dimensions only 

(Применять только к размерам макетов), значение масштабиро-
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ванного размера будет применяться только к размерам, создан-

ным в макетах (пространстве листов просмотра). 

Настройки в области Zero suppression (Подавление нулей) 

управляют отображением ведущих и конечных нулей в текстовых 

значениях размеров. Например, при использовании десятичных 

единиц измерения установка флажка Leading (Ведущие) означа-

ет, что значение 0.5000 будет отображаться как.5000. При уста-

новленном флажке Trailing (Конечные) размер 12.5000 будет вы-

глядеть как 12.5. 

С помощью полей Sub-units factor (Субразмерный фактор) 

и Sub-units suffix (Субразмерный суффикс) можно указать субра-

змерный фактор и суффикс. Например, если единица измерения 

1 м, вы можете указать субразмерный фактор 100 и субразмер-

ный суффикс см. В этом случае, когда величина размера меньше 

1, например 0.45, будет отображаться 45 см, а не 0.45 м. 

Флажки 0 feet (0 в футах) и 0 inches (0 в дюймах) управляют 

отображением нулей в значениях размеров, выраженных в футах 

и дюймах. Например, если флажок 0 feet (0 в футах) установлен, 

значение 0' 8" будет отображать как 8". При установленном 

флажке 0 inches (0 в дюймах) значение 12' 0" будет отображаться 

как 12'. 

 

 Альтернативные единицы измерения 
Вкладка Alternate Units (Альтернативные единицы) позво-

ляет показывать размеры в двух различных форматах (рис. 48). 

Типичный пример – отображение размеров одновременно в мил-

лиметрах и дюймах, например 2.00 [50.8mm]. Вкладка Alternate 

Units (Альтернативные единицы) содержит параметры, подобные 

настройкам на вкладке Primary Units (Основные единицы). Что-

бы разрешить использование альтернативных единиц, установите 

флажок Display alternate units (Отображать альтернативные еди-

ницы). 
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Рисунок 48 – Параметры альтернативных единиц 

 

Значение параметров Unit format (Формат единиц) и 

Precision (Точность) не отличается от аналогичных настроек на 

вкладке Primary Units (Основные единицы). При использовании 

форматов дробных единиц (архитектурного и дробного) вы мо-

жете выбрать между скомпонованным и нескомпонованным ви-

дами дроби. 

Настройки Multiplier for alt units (Множитель для альтер-

нативных единиц) и Round distances to (Округлять расстояния 

до) определяют переходной коэффициент между первичными и 

альтернативными единицами. Например, для преобразования 

дюймов в миллиметры задайте множитель 25.4. Это значение не 

влияет на угловые размеры. Настройка Round distances to 

(Округлять расстояния до) позволяет применять округленные 

значения к альтернативным размерам. Это округленное значение 

не зависит от первичного значения округления единиц измере-

ния. 
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Параметры Prefix (Префикс), Suffix (Суффикс) и флажки в 

области Zero supression (Подавление нулей) настраиваются так 

же, как для основных единиц. Например, чтобы разместить после 

альтернативных единиц запись мм, введите в поле Suffix (Суф-

фикс) соответствующее значение. 

С помощью переключателя Placement (Размещение) можно 

выбрать, где будут отображаться альтернативные единицы: после 

основного значения (After primary value) или под ним (Below 

primary value). 

 

 Настройки допусков 
Вкладка Tolerances (Допуски) предназначена для управле-

ния отображением и значениями допусков как для основных, так 

и для альтернативных единиц (рис. 49). Настройка Method (Ме-

тод) управляет отображением допусков. Параметр Precision 

(Точность) и флажки в областях Zero supression (Подавление ну-

лей) работают таким же образом, как на вкладках Primary Units 

(Основные единицы) и Alternate Units (Альтернативные едини-

цы), но только управляют значениями допусков. 

 

 
 

Рисунок 49 – Параметры допусков 
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В полях Upper value (Верхняя граница) и Lower value 

(Нижняя граница) можно задать верхний и нижний пределы зна-

чений параметров допусков. 

Используя поле Scaling for height (Масштабирование для 

высоты), можно установить относительный размер текстового 

значения допуска. Это коэффициент масштаба, умноженный на 

высоту текста основной единицы. Например, если задается зна-

чение 0.5, текст допуска будет равен половине размера основной 

единицы. 

В списке Vertical position (Вертикальное положение) выби-

рают вертикальное расположение основного текстового значения 

размера по отношению к тексту допуска: Bottom (Снизу), Middle 

(Посередине) или Top (Сверху). 

 

Порядок изменения существующего стиля размера: 

1. Запустить команду DIMSTYLE, чтобы вызвать диалого-

вое окно Dimension Style Manager (Менеджер стиля размера). 

2. Выбрать созданный ранее стиль размера Mech и щелк-

нуть на кнопке Modify (Изменить). Появится диалоговое окно 

Modify Dimension Style (Изменить стиль размера). 

3. На вкладке Symbols and Arrows (Символы и стрелки) за-

дать для параметра Arrow size (Размер стрелки) значение 0.125. 

4. На вкладке Text (Текст) нажать кнопку с многоточием, 

расположенную рядом со списком Text style (Стиль текста). По-

явится диалоговое окно Text Style (Стиль текста). Нажать в нем 

кнопку New (Новый) и создать стиль текста с именем DIM, ис-

пользуя шрифт romans.shx. Нажать кнопку Apply (Применить), а 

затем Close (Закрыть), чтобы вернуться в окно Modify Dimension 

Style (Изменить стиль размера). 

5. Выбрать в списке Text style (Стиль текста) стиль текста 

DIM, который только что был создан, и задать параметр Text 

height (Высота текста) равным 0.125. 

6. Нажать кнопку OK, чтобы сохранить изменения стиля 

размера и возвратиться в окно Dimension Style Manager (Мене-

джер стиля размера). Выбрать стиль размера Mech и щелкнуть на 

кнопке Set Current (Установить текущим), чтобы установить 
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данный стиль размера в качестве текущего. Нажать кнопку Close 

(Закрыть), чтобы завершить выполнение команды DIMSTYLE. 

Размеры, связанные с этим стилем, будут обновлены. 

 

2. Практическая часть  

 

Ознакомившись с теоретической частью лабораторного за-

нятия № 6 для закрепления изученного материала необходимо 

выполнить следующие задания: 

1. Вычертить в пространстве модели две проекции детали и 

нанести размеры (рис. 50). 

 

 
Рисунок 50 – Пример графического задания  

по теме «Размерные стили» 
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2. Нанести размеры в графических работах ДЗ №1 и №2. 

 

3.Вопросы для самоконтроля 

 

1. Где расположена вкладка «Размеры»? 

2. Какие основные размеры используют при оформлении 

графических документов? 

3. Что такое размерный стиль? 

4. Как называется команда, управляющая размерными сти-

лями, где она расположена? 

5. Расскажите алгоритм создания нового размерного стиля. 

6. Для чего предназначена вкладка Lines (линии), назовите 

её параметры? 

7. Назовите функции вкладки Symbols and Arrows (симво-

лы и стрелки). 

8. Как настроить текс при создании размерного стиля? 

9. Для чего необходима вкладка Fit (подгонка)? 

10. Для чего предназначена вкладка Primary Units (основ-

ные единицы)? 

11. Расскажите порядок изменения существующего раз-

мерного стиля. 
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Лабораторное занятие № 7 

«Блоки и атрибуты блоков» 

 

Цель занятия:  

- ознакомление с понятием блока в графическом редакторе 

AutoCAD; создание локального и автономного блоков; взаимо-

действие слоев блока и чертежа; создание блока с атрибутами; 

- выполнение графического задания «Создание блока основ-

ной надписи» 

 

1. Теоретические положения 

 

Блоком называется совокупность связанных объектов ри-

сунка, обрабатываемых как единый объект. Формирование часто 

используемых объектов может быть произведено всего один раз. 

Далее они объединяются в блок и при построении чертежа вы-

полняют роль «строительных материалов». Применяя блоки, лег-

ко создавать фрагменты чертежей, которые будут неоднократно 

требоваться в работе. 

Существуют два типа блоков: локальные и автономные.  

Локальные блоки – входят в состав того чертежа, в кото-

ром они были созданы.  

Автономные блоки – хранятся в виде отдельного файла 

чертежа.  

Кроме того, перенос объектов из одного файла чертежа в 

другой возможен и через буфер обмена Windows. Этот способ 

позволяет переносить объекты без изменения их свойств или с 

масштабированием, но не способствует экономии памяти. 

 

1.1 Создание блока (локального) 

 

Команда BLOCK  формирует блок для использования 

его только в текущем рисунке. Она вызывается из падающего ме-

ню Draw > Block > Make... или щелчком на пиктограмме Make 

Block на панели инструментов Draw. В результате открывается 

диалоговое окно Block Definition – рисунок 51. 
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 При создании описания блока в диалоговом окне Block 

Definition следует: 

 в поле Name: ввести уникальное имя создаваемого блока; 

 в области Base point задать координаты базовой точки 

вставки или нажать кнопку Pick point для выбора базовой 

точки с помощью мыши; 

 

 
 

Рисунок 51 – Диалоговое окно описания блока 

 

 в области Objects выделить объекты и задать способ обра-

ботки выбранных объектов после создания описания блока; 

 в области Behavior сделать следующие настройки: Scale 

uniformly – одинаковый масштаб; Allow exploding – разре-

шить расчленение; 

 в области Settings сделать следующие настройки: в поле 

Block unit: установить единицы блока; с помощью кнопки 

Hyperlink… загрузить диалоговое окно вставки гиперссылки 

Insert Hyperlink; 
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 в поле Description ввести текстовые пояснения для облегче-

ния идентификации и поиска блока впоследствии; 

 Open in block editor – открыть в редакторе блоков. Описание 

блока сохраняется в текущем рисунке. 

 

1.2 Создание автономного блока 

 

При создании автономного блока будет создан новый файл с 

фрагментом блока (рис. 52). 

 
 

Рисунок 52 – Создание автономного блока 

 

• Команда вызывается из командной строки:  

Command: WBLOCK [Enter]  
• Или более коротко:  

Command: W [Enter] 
• В ответ на команду система открывает диалоговое окно 

Write Block, средствами которого можно сформировать ав-
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тономный блок из существующих примитивов чертежа или 

локального блока.  

• Сформируем автономный блок из ранее созданного локаль-

ного блока.  

 

Опция Source позволяет задать способ определения авто-

номного блока:  

 Block позволяет создать автономный блок, используя ранее 

созданный локальный блок. Имя локального блока можно 

выбрать в раскрывающемся списке, который становится до-

ступным при выборе кнопки Block.  

 Entire drawing позволяет создать автономный блок, исполь-

зуя в качестве блока весь чертеж.  

 Objects позволяет создать автономный блок без предвари-

тельного создания локального блока. При выборе кнопки 

Objects становятся доступными панели Objects и Base point 

, необходимые для отбора объектов и задания базовой точки 

автономного блока.  

 

• Выберем  Block  

• В выпадающем списке выбрать имя ранее созданного ло-

кального блока.  

!!! Назначить имя и место сохранения НОВОГО ФАЙЛА с бло-

ком. 

 

 
 

• Завершить создание блока [OK].  

• Сохранить файл.  

• Закрыть файл со штампом.  
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1.3 Вставка блока 

 

Команда INSERT  осуществляет вставку в текущий 

чертеж предварительно определенных блоков или существующих 

файлов рисунков в качестве блока. 

Команда INSERT вызывается из падающего меню Insert > 

Block... или щелчком на пиктограмме Insert на панели инструмен-

тов Draw. При этом загружается диалоговое окно Insert (рис. 52), 

позволяющее настроить следующие параметры вставки блока: 

 

 
 

Рисунок 52 – Диалоговое окно вставки блока 

 

 В поле Name: указывается имя вставляемого блока. 

 В области Insertion point определяется точка вставки. 

 В области Scale определяется масштаб. 

 В области Rotation определяется угол поворота. 

 

При вставке одного рисунка в другой AutoCAD обрабатыва-

ет вставленный рисунок так же, как и обычное вхождение блока. 
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1.4 Взаимодействие слоев блока и чертежа 

 

Если блок создавался на любом слое (кроме слоя с именем 

0) с цветом, типом и толщиной линий, заданных явным указани-

ем, то при вставке его будет получен следующий результат:  

 блок сохраняет для объектов, входящих в его состав, цвет и 

свойства линий, которые были явно установлены;  

 при вставке его в другой чертеж будет автоматически создан 

слой, на котором были созданы исходные объекты блока.  

 

Если блок создавался на любом слое (кроме слоя с именем 

0) с цветом, типом и толщиной линий, заданных ByLayer, при 

вставке его будет получен следующий результат:  

 блок сохраняет для объектов, входящих в его состав, свой-

ства исходного слоя;  

 при вставке его в другой чертеж будет создан слой, на кото-

ром были созданы исходные объекты блока;  

 при вставке его в другой чертеж, в котором существует од-

ноименный слой, однако цвет и свойства линий отличаются, 

блок передаст объектам, входящим в его состав, свойства 

нового слоя.  

 

Если блок создавался на любом слое (кроме слоя с именем 

0) с цветом, типом и толщиной линий, заданных ByBlock, при 

вставке его будет получен следующий результат:  

 блок передаст объектам, входящим в его состав, свойства 

текущего слоя;  

 при вставке его в другой чертеж будут созданы слои, на ко-

торых были созданы исходные объекты блока.  

 

Если блок создавался на слое с именем 0 с цветом, типом и 

толщиной линий, заданных ByLayer или ByBlock, при вставке 

его будет получен следующий результат:  

 блок передаст объектам, входящим в его состав, свойства 

текущего слоя.  
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1.5 Разбиение блока 

 

Команда EXPLODE  разбивает блок на составляющие 

его объекты. 

Команда EXPLODE вызывается из падающего меню Modify 

> Explode или щелчком на пиктограмме Explode на панели ин-

струментов Modify. 

При включении блока в чертеж AutoCAD обрабатывает его 

как графический примитив. Для обеспечения работы с его от-

дельными составляющими блок необходимо разбить или «взо-

рвать». Это можно сделать и в момент вставки его в рисунок, 

установив в диалоговом окне Insert флажок Explode. 

 

1.6 Создание блока с атрибутами 

 

АТРИБУТ — специальный объект, связанный с блоком. 

Атрибут используется для хранения вместе с блоком отдельных 

текстовых строк. При вставке блока эти строки можно редакти-

ровать, т. е. однажды создав блок, в который входит атрибут, с 

каждой вставкой блока в чертеж изменять текст. Распространен-

ный пример использования атрибутов – заполнение основной 

надписи чертежа (Фамилия, наименование).  

Создание блока с атрибутами  

• Создать на поле чертежа в нужном месте атрибут (это 

строка похожая на текстовый объект).  

• Геометрические объекты и атрибуты объединить в локаль-

ный или автономный блок.  

• Затем при вставке такого блока с атрибутами система за-

просит текстовые значения атрибутов.  

• Во вставленном блоке можно изменить атрибуты двойным 

щелчком по блоку.  

 

Создание атрибута:  

• Обратиться к команде меню: Draw / Block / Define 

Attributes…  
• Откроется диалоговое окно Attribute Definition (рис. 53) 
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• В поле Tag – задать имя атрибута, которое в дальнейшем 

будет использоваться для извлечения атрибута из базы данных.  

• В поле Prompt – задать текстовое пояснение (подсказку).  

• В поле Value – можно задать значение атрибута по умол-

чанию (в дальнейшем его можно изменить).  

В области Insertion point обязательно надо указать базовую 

точку вставки атрибута одним из двух способов:  

− Кнопка Pick Point < позволяет указать нужную точку 

привязкой на чертеже.  

− Поля X, Y и Z позволяют задать числовые значения 

координат точки вставки атрибута в текущей системе коор-

динат.  

 

 
 

Рисунок 53 – Диалоговое окно Attribute Definition 

 

• Панель Text Options позволяет выбрать параметры форма-

тирования текста при выводе значения атрибута на чертеже:  

− список Justification задает способ выравнивания тек-

ста;  

− список Text Style позволяет указать стиль текста;  

− в поле Height задется высоту текста;  
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− в поле Rotation можно указать угол направления строки 

текста.  

• В области Mode можно задать режим состояние атрибута:  

− Invisible – атрибут невидим при вставке блока;  

− Constant – атрибут имеет постоянное значение при всех 

вставках блока;  

− Verify – атрибут может быть отредактирован при вставке 

блока;  

− Preset – атрибут автоматически получает значение по 

умолчанию при вставке блока.  

• Флажок Align below previous attribute разрешает устано-

вить режим выравнивания по предыдущему атрибуту.  

• Подтвердить сделанные настройки OK.  

• Сам по себе атрибут не имеет смысла. После создания ат-

рибута его надо связать с каким-либо блоком.  

 

Порядок создания блока штампа основной надписи  

• Создать геометрию штампа в слоях.  

• Занести неизменяемые текстовые объекты на слое для тек-

ста.  

• Создать атрибуты для изменяемых участков текста (Фами-

лии, названия, маркировка и проч.).  

• Объединить геометрию и атрибуты в локальный блок.  

• Организовать автономный блок из локального, сохранив 

файл в специальной папке.  

• Пользоваться профессиональным блоком в последующих 

чертежах.  

 

2. Практическая часть 

 

Изучив теоретическую часть лабораторного занятия, можно 

приступать к практическому заданию «Создание блока».  

Как выяснили ранее, блоки для Автокада – это наборы 

неких графических примитивов, объединенные в единое целое. 

Они служат для ускорения создания чертежей, позволяя исполь-

зовать повторяющиеся элементы чертежа многократно. Блоки 

можно создавать и использовать не только в пределах одного 
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чертежа, их можно экспортировать и вставлять в другие чертежи 

AutoCAD. 

Блоки очень помогают, когда, например,  нужно вставлять  

стандартные обозначения, такие как шероховатость, допуски от-

клонения формы поверхностей в машиностроении. В строитель-

стве – это различные обозначения интерьера зданий. В электро-

технике блоками могут быть обозначения элементов электриче-

ских схем. 

В сети можно отыскать множество готовых библиотек бло-

ков по нужной тематике, но полезно уметь создавать блоки само-

стоятельно, ибо часто найти то, что нужно именно для конкрет-

ных чертежей бывает затруднительно.  

  

Графическое задание «Создание блока» заключается в сле-

дующем: из имеющей рамки основной надписи (созданной на ла-

бораторном занятии № 1, рис. 54), сделаем блок, чтобы потом 

вставлять ее многократно там, где необходимо. 

 

 
 

Рисунок 54 – Основная надпись 

 

Для создания блока нужно выполнить следующие действия: 

1. Выделяем все элементы, которые нам необходимо 

включить в блок (рис. 55). 
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Рисунок 55 – Выделенные элементы,  

которые будут включены в блок 

 

2. Экспортируем выбранные элементы в блок, зайдя в 

меню “файл”, выбрав “экспорт”, указав путь, имя и тип файла 

(рис. 56). 

 

 

 

Рисунок 56 – Экспортирование выбранных элементов в блок 
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Далее нужно курсором указать базовую точку блока, по ко-

торой он потом будет вставляться. После этого блок исчезнет с 

экрана.  

3. Для вставки готового блока, идем в меню “вставка” 

(рис. 57), выбираем “блок”. Выбираем нужный блок с помощью 

браузера (кнопка обзор). Настраиваем параметры вставки: 

 

 

 

Рисунок 57 – Меню «Вставка» для вставки готового блока 

 

- Точка вставки – либо указывать мышью, либо указать ко-

ординаты. У блока есть базовая точка, по которой он вставляется 

и, по-моему, всегда удобнее указывать мышью. 

- Масштаб – можно при вставке указывать мышью (растяги-

вать и сжимать), но это, на мой взгляд, не очень удобно – я пред-

почитаю указать цифрами по осям. 

- Угол поворота – можно при вставке его менять, указав 

нужный мышью либо задав числом. 

- Расчленить – если поставить галку, после вставки блок бу-

дет разбит на отдельные, составляющие его элементы. 

4.  Для повторной вставки того же блока с теми же парамет-

рами, достаточно просто два раза нажать “enter”. 

 

3. Вопросы для самоконтроля 

 

1. Что называют блоком в графическом редакторе Auto-



84 

 

CAD? 

2. Какие типы блоков вы знаете? 

3. Расскажите алгоритм создания локального блока. 

4. Расскажите алгоритм создания автономного блока. 

5. Как осуществить вставку блока в текущий чертеж? 

6. Как называется команда, осуществляющая разбиение 

блока на составляющие его объекты и где она располо-

жена? 

7. Что такое атрибут? 

8. Расскажите алгоритм создания атрибута. 

9. Расскажите алгоритм создания блока с атрибутами. 
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Лабораторное занятие № 8 

«Видовые экраны» 

 

Цель занятия:  
- ознакомиться с понятием видового экрана, основными 

настройками; 

- научиться создавать видовой экран, масштабировать видо-

вой экран; переходить в пространство МОДЕЛЬ и область отоб-

ражения видового экрана, выполнять подрезку и блокировку ви-

дового экрана; научиться отключать рамки видового экрана и 

слои в видовых экранах. 

- выполнение графического задания «Работа с видовыми 

экранами». 

 

1. Теоретические положения 

 

Просмотр изображения из пространства модели на листе 

возможен только в видовых экранах. По умолчанию на листе 

имеется один видовой экран. Если удалить видовой экран, то 

лист будет чистый.  

Видовой экран – это примитив системы AutoCAD, который 

существует только в пространстве листа и имеет, в основном, 

прямоугольную форму (может быть подрезан линией другой гео-

метрии). Внутри видового экрана устанавливается вид на объек-

ты, построенные в пространстве модели. 

В пространстве модели тоже есть видовые экраны. Но там 

они являются не примитивами, а элементами деления на части 

графического экрана. Видовые экраны пространства модели еще 

называют неперекрывающимися видовыми экранами, а про-

странства листа – плавающими видовыми экранами. 

Перечислим несколько свойств видовых экранов: 

 видовые экраны являются реальными объектами: их 

можно растянуть, переместить, удалить, разместить на разных 

слоях; 

 отображение пиктограммы ПСК можно задавать отдель-

но для каждого видового экрана. Активным может быть только 
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один экран. Зумирование и ориентация объектов в одном экране 

не влияют на изображения в других экранах; 

 находясь в пространстве листа, можно продолжить рабо-

ту с чертежом в активном видовом экране. 

 

1.1 Создание видовых экранов 

 

Большинство операций по созданию и редактированию пла-

вающих видовых экранов выполняется с помощью группы 

Viewports (Видовые экраны), расположенной на вклад-

ке View (Отображение) ленты, или на панели инструмен-

товViewports (Видовые экраны) (рисунок 58) 
 

 
 

Рисунок 58 – Панель инструментов Viewports  

(Видовые экраны) 

 

Чтобы вызвать диалоговое окно Viewports (Видовые экра-

ны) (рис. 59), находясь в пространстве листа, необходимо щелк-

нуть на кнопку New (Новый) в группе Viewports (Видовые экра-

ны) на вкладке View (Отображение) ленты или на кнопку Display 

Viewports Dialog (Отобразить диалоговое окно видовых экранов) 

на панели инструментов Viewports (Видовые экраны). Можно 

также набрать команду VPORTS. Того же результата можно до-

биться, выполнив команду меню View > Viewports > New 

Viewports (Вид > Видовые экраны > Новые видовые экраны). 
Список Standard viewports (Стандартные видовые экраны) 

позволяет выбрать количество плавающих видовых экранов и их 

расположение на листе. При этом в области Preview (Просмотр) 

схематично показывается будущее расположение видовых экра-

нов и имя каждого из них. При выбранном режиме 2D в спис-

ке Setup (Режим) в каждом видовом экране устанавливается вид 

всей модели. Если задать режим 3D, то в видовых экранах будут 

создаваться стандартные виды модели. 
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В раскрывающемся списке Change view to (Сменить вид на) 

задают вид в конкретном видовом экране. Например, при вы-

бранном режиме 3D из этого списка можно выбрать один из 

стандартных видов или задать изометрическое отображение мо-

дели. 

В поле Viewport Spacing (Расстояние) указывают расстоя-

ние, на котором будут расположены видовые экраны друг от дру-

га на листе.  

 

 
 

Рисунок 59 – Диалоговое окно Viewports (Видовые экраны) 

 

Понятно, что это поле становится активным только при со-

здании двух и более плавающих видовых экранов. 

Выполнив все необходимые настройки, нажмите кноп-

ку OK. При этом диалоговое окно закроется, а в командной стро-

ке появится запрос: 
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Specify first corner or [Fit] <Fit>: 

В ответ нужно задать первую угловую точку с помощью 

мыши или нажать клавишу Enter, чтобы видовые экраны заняли 

всю печатаемую область листа. Если установлена первая точка, 

то в командной строке появится следующее приглашение: 

Specify opposite corner: 

Далее необходимо указать противоположный угол прямо-

угольной области, в которую будут вписаны все видовые экраны. 

Указанный контур будет заполнен плавающими видовыми экра-

нами. 

 

1.2 Создание плавающего видового экрана сложной 

формы 
 

AutoCAD позволяет создать экраны неправильной формы, 

для чего необходимо щелкнуть на кнопке Create Polygonal (Со-

здать многоугольный) в группе Viewports (Видовые экраны) на 

вкладке View (Отображение) ленты или на кнопке Polygonal 

Viewport (Многоугольный видовой экран) на панели инструмен-

тов Viewports (Видовые экраны). Можно также выполнить ко-

манду меню View > Viewports > Polygonal Viewport (Вид > Ви-

довые экраны > Многоугольный видовой экран). В этом случае 

граница плавающего видового экрана будет создана из прямоли-

нейных и дуговых сегментов. 

После запуска команды появится приглашение: 

Specify start point: 

 

Далее нужно задать первую точку. После этого появится но-

вый запрос: 

Specify next point or [Arc/Length/Undo]: 

 

Затем продолжить указывать точки или выбирать один из 

предлагаемых параметров: 

• при выборе параметра Arc появляется возможность добав-

лять дуговые сегменты; 

• если выбрать параметр Length, то будет вычерчиваться 

линейный сегмент заданных длины и направления; 
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• параметр Undo удаляет последний созданный фрагмент. 

Указав последнюю точку, необходимо нажать клави-

шу Enter, чтобы завершить создание границ видового экрана. 

Понятно, что контур видового экрана должен быть замкнутым, 

поэтому если последняя указанная точка не будет совпадать с 

начальной, программа автоматически проведет линейный сег-

мент, чтобы получить замкнутый объект. 

 

1.3 Создание плавающего видового экрана из объекта 
 

AutoCAD позволяет создавать плавающие видовые экраны 

из любых замкнутых объектов. Чтобы преобразовать замкнутую 

полилинию, эллипс, сплайн, область или круг в видовой экран, 

необходимо выполнить команду меню View > Viewports > 

Object (Вид > Видовые экраны > Объект) или щелкнуть на кноп-

ке Create from Object (Создать из объекта) в груп-

пе Viewports (Видовые экраны) на вкладке View (Отображение) 

ленты либо на кнопке Convert Object to 

Viewport (Преобразовать объект в видовой экран) на панели ин-

струментов Viewports (Видовые экраны). Появится запрос: 

Select object to clip viewport: 

 

Далее нужно выделить подходящий замкнутый объект. Он 

тут же будет преобразован в плавающий видовой экран, в кото-

ром появится изображение модели. 

 

1.4 Редактирование плавающих видовых экранов 
 

Созданный плавающий видовой экран можно переместить, 

изменить его размеры или удалить, предварительно выделив его. 

Как и другие объекты, плавающие видовые экраны можно 

редактировать с помощью ручек. Однако наиболее интересной 

возможностью является переопределение границ видового экрана 

с использованием команды VCLIP. Данная команда вызывается 

щелчком на кнопке Clip existing viewport (Подрезать существу-

ющий видовой экран) на панели инструментов 

Viewports (Видовые экраны). При этом появляется возможность 
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изменять форму плавающего видового экрана в соответствии с 

новыми границами. Чтобы обрезать видовой экран, следует либо 

указать существующий замкнутый контур, либо создать его в 

процессе выполнения команды. 

Выделите плавающий видовой экран, который собираетесь 

обрезать, а затем запустите команду VPCLIP, или сначала запу-

стите команду VPCLIP, а затем, в ответ на запрос: 

Select clipping object or [Polygonal/Delete] <Polygonal>: 

 

укажите замкнутый объект, который будет выступать в ка-

честве границы подрезки. 

Если в ответ на данное приглашение нажать Enter (то есть 

выбрать параметр Polygonal), то появится возможность создать 

границу подрезки вручную. Как и при создании видового экрана 

сложной формы, в данном случае отсекающая граница формиру-

ется из прямолинейных и дуговых сегментов. 

Удалить некоторую отсекающую замкнутую область можно 

с помощью параметра Delete, который доступен лишь в том слу-

чае, если выбранный плавающий видовой экран является подре-

занным. 

 

1.5 Работа с моделью в видовом экране 
 

После создания и правки плавающих видовых экранов в 

каждом из них будет отображаться один и тот же вид модели. 

Однако в каждом видовом экране необходимо настроить нужный 

вид. Для этого следует переключиться из пространства листа в 

видовой экран, что можно сделать двумя способами. 

• Дважды щелкнуть кнопкой мыши на видовом экране, ко-

торый нужно выбрать. 

• Щелкнуть на кнопке PAPER (Бумага), расположенной в 

строке состояния. При этом кнопка изменит свое название на 

MODEL (Модель), а в графической области будет активизирован 

один из плавающих видовых экранов. Чтобы переключиться в 

нужный видовой экран, щелкните на нем кнопкой мыши. 
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Для последовательного переключения между активизиро-

ванными видовыми экранами нажимайте сочетание клавиш 

Ctrl+R. 

 

Граница активизированного видового экрана выделяется 

толстой линией. 

Переключившись в один из плавающих видовых экранов, 

мы фактически оказываемся в пространстве модели. Здесь можно 

редактировать или создавать новые объекты, как будто находясь 

на вкладке Model (Модель), и поэтому изменения будут отобра-

жаться во всех видовых экранах. 

Рассмотрим команды, которые предоставляет контекстное 

меню видового экрана. Выделите плавающий видовой экран (его 

границы отобразятся в виде штриховой линии), а затем щелкните 

правой кнопкой мыши, чтобы вызвать контекстное меню 

(рис. 60). 

Если на листе расположено несколько видовых экранов, то, 

скорее всего, они имеют небольшие размеры и работать с моде-

лью в таких маленьких окнах не очень удобно. Однако можно 

временно раздвинуть один плавающий видовой экран на всю 

графическую зону. Для этого необходимо выбрать пункт 

Maximize Viewport (Развернуть видовой экран) в контекстном 

меню или просто дважды щелкнуть на рамке неактивного видо-

вого экрана. Увеличенный видовой экран с красной окантовкой 

займет всю графическую область. Здесь можно выполнять все 

действия, что и на вкладке Model (Модель), однако команды 

масштабирования и панорамирования не изменят отображения 

объектов в видовом экране. Чтобы свернуть экран, нужно вы-

звать контекстное меню и выбрать в нем пункт Minimize 

Viewport (Свернуть видовой экран). 
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Рисунок 60 – Контекстное меню видового экрана 

 

Максимизировать видовой экран можно, запустив команду 

VPMAX, а минимизировать – VPMIN. Кроме того, в строке со-

стояния присутствует кнопка Maximize Viewport (Развернуть 

видовой экран) , раздвигающая границы экрана, а свернуть 

экран можно с помощью кнопки Minimize Viewport (Свернуть 

видовой экран) , которая появляется на ее месте. 
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Команда Display Viewport Objects (Отображение объектов 

на видовых экранах) контекстного меню предоставляет возмож-

ность включить или отключить видимость объектов на видовом 

экране. Выбрав пункт No (Нет), с экрана убираются все объекты, 

содержащиеся в текущем видовом экране. Такая операция может 

быть полезной, если необходимо зрительно разгрузить простран-

ство листа. Чтобы вернуть объекты на свое место, нужно устано-

вить флажок Yes (Да). 

Команда контекстного меню Display Locked (Отображать 

блокированные) позволяет фиксировать масштаб видового экра-

на. По умолчанию масштаб каждого видового экрана можно из-

менять отдельно, однако если установить флажок Yes (Да), то 

при попытке масштабировать изображение в видовом экране бу-

дет изменяться масштаб отображения всего пространства листа. 

Чтобы переключиться обратно в пространство листа, необ-

ходимо дважды щелкнуть кнопкой мыши на область, не занятую 

видовыми экранами, или нажать кнопку MODEL (Модель), рас-

положенную в строке состояния. 

 

1.6 Масштабирование видового экрана 

 

Обычно печать из пространства листа происходит в мас-

штабе 1:1. Поэтому, чтобы добиться правильной компоновки 

чертежа, необходимо отдельно установить масштабы каждого 

видового экрана. Чтобы точно подобрать масштаб чертежа, сле-

дует указать масштаб видового экрана по отношению к простран-

ству листа. Данный масштабный коэффициент определяют путем 

деления единиц пространства листа на единицы пространства 

модели. Точно задать масштаб можно с помощью параметра XP 

команды ZOOM. Например, чтобы задать изображению масштаб 

1:10, необходимо ввести 1/10XP в ответ на запрос команды 

ZOOM. 
Указать масштаб конкретного видового экрана можно также 

с помощью раскрывающегося списка панели инструментов 

Viewports (Видовые экраны). После установки масштаба изобра-

жения на видовом экране следует заблокировать этот масштаб-

ный коэффициент от случайных изменений. Для этого необходи-
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мо выполнить команду Display Locked > Yes (Отображать бло-

кированные > Да) в контекстном меню плавающего видового 

экрана. 

 

1.7 Управление видимостью объектов внутри  

видового экрана 
 

В каждом видовом экране можно отдельно настроить види-

мость слоев. Например, таким образом можно скрыть штриховку 

или повторяющийся на нескольких видовых экранах текст. 

Для этого следует дважды щелкнуть в области нужного ви-

дового экрана, чтобы сделать его активным. 

Если нажать кнопку Layer Properties (Свойства слоя)  в 

группе Layers (Слои) на вкладке Home (Основная) ленты или та-

кую же кнопку на панели инструментов Layers (Слои), откроется 

палитра Layer Properties Manager (Менеджер свойств слоя) 

(рис. 61). 
 

 
 

Рисунок 61 – Палитра Layer Properties Manager (Менеджер 

свойств слоя), вызываемая в режиме Layout (Лист) 

 

Следует обратить внимание на то, что данное окно несколь-

ко отличается от аналогичного, вызываемого из пространства мо-

дели (см. лаб. работу № 1, рисунок 13). В частности, появились 

новые столбцы, отвечающие за свойства объектов внутри редак-

тируемого видового экрана: VP Freeze (Замороженный в 
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ПВЭ), VP Color (Цвет в ПВЭ), VP Linetype (Тип линии в 

ПВЭ), VP Lineweight (Толщина линии в ПВЭ) и VP Plot 

Style (Стиль печати в ПВЭ). Назначение этих столбцов не отли-

чается от аналогичных без дополнения VP, с той лишь поправ-

кой, что их изменение ограничивается редактируемым плаваю-

щим видовым экраном. 

Например, чтобы сделать все объекты какого-либо слоя не-

видимыми, нужно щелкнуть напротив названия этого слоя в 

столбце VP Freeze (Замороженный в ПВЭ), или, например, чтобы 

изменить цвет объектов слоя внутри видового экрана, необходи-

мо воспользоваться столбцом VP Color (Цвет в ПВЭ). 

Подготовку листа к выводу на печать на этом этапе можно 

считать завершенной. 

 

2. Практическая часть 

 

Для закрепления теоретической части данной лабораторной 

работы необходимо выполнить графическое задание «Работа с 

видовыми экранами»: 

1. Выполнить чертеж кронштейна по рисунку 62 форматом 

А3. 

2. На листе создать три видовых экрана и в каждом из них 

расположить один проекционный вид. Текстовые надписи и 

штамп на чертеж не вставлять. 

 

3. Вопросы для самоконтроля 

 

1. Что такое видовой экран? 

2. Назовите свойства видовых экранов. 

3. Как создать видовой экран? 

4. Как создать плавающий видовой экран сложной формы? 

5. Как создать плавающий видовой экран из объекта? 

6. Как редактировать плавающий видовой экран? 

7. Как осуществить работу с моделью в видовом экране? 

8. Как масштабировать видовой экран? 

9. Как управлять видимостью объектов внутри видового экра-

на? 
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Рисунок 62 – Графическое задание  

«Работа с видовыми экранами» 
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Лабораторное занятие № 9  

«Вывод чертежа на печать. 

 

Цель занятия:  

- изучить параметры настройки печати чертежей, стили пе-

чати; конфигурирование печатающих устройств; 

- выполнить графическое задание «Построение уступа и его 

элементов»  

 

1. Теоретические положения 

 

Закончив работу по созданию и компоновке чертежа, можно 

приступить к настройке печати. Вид распечатанного чертежа бу-

дет зависеть от нескольких составляющих: настроек листа, рас-

смотренных выше, присоединенной таблицы печати и, конечно 

же, конфигурации самого печатающего устройства. Поэтому, 

прежде чем обращаться к выводу чертежа на печать, рассмотрим 

работу со стилями печати и конфигурирование печатающих 

устройств. 

 

1.1 Стили печати 

 

Стиль печати представляет собой свойство объекта, опре-

деляющее, как он будет распечатан на бумаге. Стиль печати объ-

единяет набор параметров объекта, таких как цвет, тип и толщина 

линии и т. п. В отличие от других свойств, стиль печати может и 

не использоваться, и в таком случае программа напечатает объект 

в соответствии с другими свойствами. 

Использование стилей печати позволяет более гибко управ-

лять изображением объектов на экране и бумаге. Например, на 

мониторе линия изображена одним цветом, а при использовании 

стиля печати и выводе чертежа на бумагу цвет линии может быть 

уже совсем иным. При этом использование стилей печати не вли-

яет на отображение объектов на мониторе. 

Стили печати можно объединять в таблицы стилей печати, 

которые хранятся в специальных файлах. 
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1.1.1 Цветозависимые и именованные стили печати 

 

В AutoCAD используются две разновидности стилей печати. 

• Цветозависимые стили печати унаследованы из преды-

дущих версий программы. При их использовании внешний вид 

объекта зависит от его цвета, то есть с каждым определенным 

цветом связаны конкретные настройки. Существенным недостат-

ком такого способа является то, что объекты одного цвета на бу-

маге будут выглядеть одинаково. Например, вы не сможете сде-

лать так, чтобы все объекты одного цвета имели различный тип 

линий. Цветозависимые таблицы стилей печати хранятся в фай-

лах с расширением CTB. 

• При использовании именованных стилей печати вид объ-

екта на бумаге не зависит от его цвета. Каждому объекту может 

быть присвоен произвольный стиль печати. Таблицы именован-

ных стилей печати хранятся в файлах с расширением STB. 

Одновременно в программе может использоваться только 

один тип таблицы стилей печати – либо цветозависимый, либо 

именованный. Тип стиля печати можно выбрать на вкладке Plot 

and Publish (Печать и публикация) диалогового окна Options 

(Параметры) (рис. 63), которое можно вызвать, выбрав в кон-

текстном меню программы пункт Options (Параметры). 

Щелчок на кнопке Plot Style Table Settings (Настройки таб-

лицы стилей печати) приводит к открытию одноименного диало-

гового окна (рис. 64). 
В этом окне переключатель по умолчанию установлен в по-

ложение Use color dependent plot styles (Использовать цветоза-

висимые стили печати). При этом в области Current plot style 

table settings (Текущие настройки таблицы стилей печати) досту-

пен только один раскрывающийся список – Default plot style 

table (Таблица стилей печати, заданная по умолчанию), в кото-

ром можно указать файл с цветозависимой таблицей стилей печа-

ти, используемой по умолчанию. 
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Рисунок 63 – Вкладка Plot and Publish (Печать и публика-

ция) диалогового окна Options (Параметры) 
 

 
 

Рисунок 64 – Диалоговое окно настройки стилей печати 
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После установки переключателя Default plot style behavior 

for new drawings (Стили печати, заданные по умолчанию для но-

вых чертежей) в положение Use named plot styles (Использовать 

именованные стили печати) станут доступными остальные рас-

крывающиеся списки. В данном случае в списке Default plot style 

table (Таблица стилей печати, заданная по умолчанию) присут-

ствуют только файлы с расширением STB, из которых можно вы-

брать таблицу именованных стилей печати, используемую по 

умолчанию. В раскрывающемся списке Default plot style for 

layer 0 (Стиль печати по умолчанию для слоя 0) указывают стиль 

для слоя 0 в новых чертежах. По умолчанию присутствует только 

значение Normal (Обычный). Стиль печати, присваиваемый по 

умолчанию создаваемым объектам, выбирают из списка Default 

plot style for objects (Стиль печати, заданный по умолчанию для 

объектов), который содержит значения ByLayer (По слою), 

ByBlock (По блоку) и Normal (Обычный). 

Важно отметить, что параметры, измененные в окне Plot 

Style Table Settings (Настройки таблицы стилей печати), будут 

применяться только к новым чертежам или к открываемым доку-

ментам, созданным в программе 14-й и более ранних версий, то 

есть на текущий чертеж эти параметры не окажут никакого воз-

действия. Поэтому выбирать тип стиля печати необходимо перед 

созданием нового чертежа. 

 

1.1.2 Создание таблицы стилей печати 

 

В AutoCAD изначально присутствует некоторый набор как 

цветозависимых, так и именованных стилей печати. Однако при 

желании вы можете создать собственную таблицу стилей, причем 

каждая созданная таблица стилей печати будет являться отдель-

ным файлом. Новый набор стилей печати создают с помощью 

мастера Add Plot Style Table (Добавить таблицу стилей печати), 

который можно вызвать с помощью команды меню Tools > 

Wizards > Add Plot Style Table (Сервис > Мастера > Добавить 

таблицу стилей печати) либо File > Plot Style Manager (Файл > 

Менеджер стилей печати) и дважды щелкнув в открывшемся 
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окне на значке Add-A-Plot Style Table Wizard (Мастер добавле-

ния таблицы стилей печати). 

Попробуем создать с помощью данного мастера новую таб-

лицу стилей печати. 

1. Из первого окна мастера можно почерпнуть информацию 

о его назначении и о таблицах стилей печати в целом. Щелкнуть 

на кнопке Далее, чтобы начать работу. Откроется окно, в кото-

ром необходимо выбрать способ создания новой таблицы 

(рис. 65). 

 

 
 

Рисунок 65 – Первое окно мастера добавления  

таблицы стилей печати 

 

2. Установить переключатель в положение Start from 

scratch (С самого начала), чтобы создать таблицу стилей печати с 

чистого листа. Положение переключателя Use an existing plot 

style table (Использовать уже существующую таблицу стилей пе-

чати) позволяет воспользоваться существующей таблицей для со-

здания новой. Можно также установить переключатель в поло-

жение Use My R14 Plotter Configuration (CFG) (Использовать 

CFG-файл конфигурации AutoCAD) или Use a PCP or PC2 file 

(Использовать импортируемые параметры перьев из PCP- или 
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PCP2-файла). Перейти к следующему окну (рис. 66), щелкнув на 

кнопке Далее. 

 

 
 

Рисунок 66 – Окно выбора способа создания новой таблицы 
 

3. Установить переключатель в положение Color-Dependent 

Plot Style Table (Цветозависимая таблица стилей печати), чтобы 

создать цветозависимую таблицу. Выбрав вариант Named Plot 

Style Table (Именованная таблица стилей печати), вы создадите 

именованную таблицу стилей. Перейти к следующему окну ма-

стера (рис. 67). 
4. Введите имя создаваемой таблицы стилей в поле File 

name (Имя файла) и запустите последнее окно (рис. 68), щелкнув 

на кнопке Далее.  

5. В последнем окне находится только один флажок Use this 

plot style table for new and pre-AutoCAD 2010 drawings (Ис-

пользовать эту таблицу стилей печати для новых чертежей и чер-

тежей версий ранее AutoCAD 2010), после установки которого 

создаваемый стиль печати будет по умолчанию подключаться ко 

всем новым чертежам. Щелкнув на кнопке Plot Style Table 

Editor (Редактор таблиц стилей печати), открывается одноимен-
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ное окно, позволяющее отредактировать еще не созданную таб-

лицу стилей. 

6. Завершить работу мастера нажатием кнопки Готово. 

 

 
 

Рисунок 67 – Окно определения имени файла 

 

 
 

Рисунок 68 – Заключительное окно мастера 
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1.1.3 Редактирование таблицы стилей печати 

 

Редактирование таблицы стилей печати заключается в до-

бавлении или удалении стилей, в их переименовании или изме-

нении параметров (цвет, тип, толщина и т. п.). Для редактирова-

ния таблицы предназначено диалоговое окно Plot Style Table 

Editor (Редактор таблиц стилей печати), которое вызывают 

щелчком на одноименной кнопке в последнем окне мастера Add 

Plot Style Table (Добавить таблицу стилей печати) или на кнопке 

Edit (Правка)  в окне Page Setup (Параметры страницы). Это 

же окно можно запустить, дважды щелкнув на названии нужного 

стиля в окне Plot Styles (Стили печати). 
В диалоговом окне Plot Style Table Editor (Редактор таблиц 

стилей печати) для редактирования стилей печати предназначены 

две вкладки: Table View (Таблица) и Form View (Карточка). Обе 

вкладки предоставляют одни и те же параметры для редактиро-

вания, но в разной форме. Вид окна будет различаться лишь для 

разных стилей печати. Как выглядит вкладка Table View (Табли-

ца) при редактировании именованной таблицы стилей печати 

acad.stb, показано на рисунке 69. 

Нетрудно заметить, что данная таблица содержит два стиля 

печати: Normal (Обычный) и Style 1 (Стиль 1). Стиль Normal 

(Обычный) присутствует во всех именованных таблицах стилей и 

не поддается редактированию. Следует отметить, что стиль печа-

ти Style 1 (Стиль 1) появится, только когда вы нажмете кнопку 

Add Style (Добавить стиль). Каждое следующее нажатие этой 

кнопки создает новые стили (следующим будет Style 2 (Стиль 2)) 

с параметрами по умолчанию. Чтобы изменить какой-либо пара-

метр стиля, щелкните на соответствующей строке, а затем выбе-

рите нужное значение в раскрывающемся списке. Чтобы удалить 

лишний стиль печати, выделите соответствующий столбец и 

щелкните на кнопке Delete Style (Удалить стиль). 

Просмотр стилей в табличном виде удобен тем, что можно 

легко сравнить одноименные параметры различных стилей. Од-

нако если вы редактируете один стиль, то вам, возможно, больше 

понравится работать на вкладке Form View (Карточка). Вид дан-
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ной вкладки при редактировании цветозависимой таблицы сти-

лей печати acad.ctb показан на рисунке 70. 

 

 
 

Рисунок 69 – Вкладка Table View (Таблица) диалогового ок-

на Plot Style Table Editor (Редактор таблиц стилей печати) 
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Рисунок 70 – Вкладка Form View (Карточка) диалогового 

окна Plot Style Table Editor (Редактор таблиц стилей печати) 

 

Как видно, почти все параметры, присутствующие на 

предыдущей вкладке, есть и здесь, только в несколько ином виде. 

В поле Plot styles (Стили печати) перечислены все цветозависи-

мые стили (всего их 255 – по количеству цветов). Важно отме-

тить, что кнопки Add Style (Добавить стиль) и Delete Style (Уда-

лить стиль) неактивны, так как цветозависимые таблицы не под-

держивают создание и удаление стилей печати. Кроме того, от-

сутствует возможность переименования стиля. 

После изменения необходимых параметров щелкните на 

кнопке Save As (Сохранить как), чтобы сохранить таблицу стилей 

под новым именем. Если нужно сохранить настройки в текущем 
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файле, тогда следует нажать кнопку Save & Close (Сохранить и 

закрыть). 

 

1.1.4 Подключение таблицы стилей печати к чертежу 

 

Завершающим этапом использования таблицы стилей печа-

ти является ее подключение к чертежу. Таблицу стилей можно 

назначить пространству моделей или любому пространству ли-

ста. Для этого необходимо: 

1. Открыть чертеж и перейти на нужную вкладку графиче-

ской области. 

2. Щелкнуть правой кнопкой мыши на корешке вкладки и в 

открывшемся контекстном меню выбрать пункт Page Setup 

Manager (Менеджер параметров страницы). В появившемся окне 

щелкнуть на кнопке Modify (Изменить). Откроется окно Page 

Setup (Параметры страницы). 

3. В раскрывающемся списке Plot style table (pen 

assignments) (Таблица стилей печати (присвоение перьев)) вы-

брать таблицу стилей печати. Если выбрать вкладку Model (Мо-

дель), то на вопрос Assign this plot style table to all layouts? 

(Применить указанную таблицу стилей печати ко всем листам?) 

ответить Да или Нет нажатием соответствующей кнопки. Если 

мы находимся в пространстве листа, то нужно установить фла-

жок Display plot styles (Показать стили печати), чтобы просмот-

реть стили печати, не выводя чертеж на бумагу. 

 

1.1.5 Присоединение стиля печати к слою или объекту 

 

Присоединить стиль печати к слою или объекту можно, 

только если применяется именованная таблица стилей печати. В 

случае же использования цветозависимой таблицы стилей невоз-

можно самостоятельно назначить какому-либо объекту или слою 

стиль печати, так как при этом стили печати присваиваются ав-

томатически в зависимости от цвета объекта. Поэтому, чтобы 

подключить конкретный стиль печати к объекту или слою, пред-

варительно необходимо в настройках программы назначить при-

менение именованных стилей печати. Для этого в диалоговом 
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окне Plot Style Table Settings (Настройки таблиц стилей печати) 

(см. рис. 63) нужно установить переключатель в положение Use 

named plot styles (Использовать именованные стили печати) и 

нажать кнопку OK, а затем создать новый чертеж, в котором бу-

дут использоваться именованные стили печати. 

Обычно стили печати назначаются не каждому объекту в 

отдельности, а слою, на котором данные объекты находятся. Что-

бы применить именованный стиль печати к слою, необходимо 

выполнить следующие действия: 

1. Вызвать диалоговое окно Layer Properties Manager (Ме-

неджер свойств слоев), щелкнув на одноименной кнопке на пане-

ли инструментов Layers (Слои) или на кнопке Layer Properties 

(Свойства слоя) в группе Layers (Слои) на вкладке Home (Ос-

новная) ленты, либо выполнив команду меню Format > Layer 

(Формат > Слои). 

2. Щелкнуть на значении столбца Plot Style (Стиль печати) 

нужного слоя. На экране появится диалоговое окно Select Plot 

Style (Выбор стиля печати) (рис. 71). 

3. В раскрывающемся списке Active plot style table (Актив-

ная таблица стилей печати) необходимо указать присоединяемую 

таблицу стилей. При этом в области Plot styles (Стили печати) 

отобразятся все стили, содержащиеся в данной таблице. В случае 

необходимости можно отредактировать выбранную таблицу сти-

лей, щелкнув на кнопке Editor (Редактор). 

4. Выбрать нужный стиль в окне Select Plot Style (Выбор 

стиля печати). Затем нажать кнопку OK, чтобы закрыть окно. 

 

Если необходимо назначить стиль печати одному объекту, 

это можно сделать с помощью палитры свойств. 

1. Выделить нужный объект любым известным способом. 

Затем щелкнуть правой кнопкой мыши и в контекстном меню 

выбрать  пункт Properties (Свойства). 

2. На открывшейся палитре Properties (Свойства) найти 

раскрывающийся список Plot style (Стиль печати) и выбрать в 

нем элемент Other (Другой). Вновь появится диалоговое окно 

Select Plot Style (Выбор стиля печати) (см. рис. 71), в котором 

необходимо определить стиль печати выбранного объекта. 
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Таким же образом можно назначить стиль печати всему ви-

довому экрану, так как он также является объектом. 

 

 
 

Рисунок 71 – Окно выбора стиля печати 

 

1.2 Конфигурирование печатающих устройств 

 

Все принтеры и плоттеры, установленные в Windows, мож-

но использовать для печати в AutoCAD. Однако печатать не на 

настольном принтере, а на плоттере, то лучше воспользоваться 

специальными драйверами, входящими в состав программы. Та-

кие драйверы позволяют использовать все возможности плотте-

ров большого формата. 
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1.2.1 Добавление печатающего устройства 

 

Для конфигурации печатающего устройства служит мастер 

добавления плоттера, который можно вызвать одним из следую-

щих способов: 

• выполнив команду Tools > Wizards > Add Plotter (Сервис 

> Мастера > Добавить плоттер); 

• выполнив команду File > Plotter Manager (Файл > Мене-

джер плоттеров) и дважды щелкнув в открывшемся окне на знач-

ке Add-A-Plotter Wizard (Мастер установки плоттера). 

В любом случае появится окно мастера добавления печата-

ющего устройства – Add Plotter (Добавить плоттер). Первое окно 

мастера расскажет о его назначении и о тех шагах, которые при-

дется пройти в процессе добавления нового плоттера. Щелкнув 

на кнопке Далее, можно начать процесс добавления печатающего 

устройства (рис. 72). 

 

 
 

Рисунок 72 – Начало установки плоттера 
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Установить переключатель в положение My Computer 

(Мой компьютер) и нажать кнопку Далее, чтобы открыть окно 

Plotter Model (Модель плоттера) (рис. 73). 

 

 
 

Рисунок 73 – Окно выбора модели плоттера 

 

В списке слева выбрать производителя печатающего 

устройства, а справа – конкретную модель плоттера, после чего с 

помощью кнопки Далее перейти в следующее окно. Если имеется 

файл конфигурации плоттера, сделанный в старых версиях про-

граммы (такие файлы имеют расширение PCP или PC2), то на 

данном этапе можно импортировать эту информацию в формат 

PC3. 

В следующем окне мастер предложит выбрать порт, посред-

ством которого плоттер подключается к компьютеру. Щелкнуть 

на кнопке Далее, чтобы открыть новое окно. 

Ввести нужное имя плоттера в поле Plotter Name (Имя 

плоттера) и открыть последнее окно мастера конфигурации плот-

тера (рис. 74), щелкнув на кнопке Далее. 



112 

 

 
 

Рисунок 74 – Окно Finish (Готово) мастера установки плоттера 
 

Последнее окно мастера содержит кнопки, предназначенные 

для редактирования конфигурации и калибровки плоттера. Нуж-

но щелкнуть на кнопке Готово, чтобы завершить работу по со-

зданию файла конфигурации плоттера. Данный файл можно уви-

деть в окне Plotters (Плоттеры), которое появляется после вы-

полнения команды File > Plotter Manager (Файл > Менеджер 

плоттеров). 

 

1.2.2 Редактирование конфигурации 

 

Приступить к редактированию конфигурации плоттера 

можно, щелкнув на кнопке Edit Plotter Configuration (Редакти-

ровать конфигурацию плоттера) в последнем окне мастера уста-

новки плоттера (см. рис. 74). Если этого не сделать, то дважды 

щелкнуть кнопкой мыши на файле конфигурации нужного плот-

тера в окне Plotters (Плоттеры), откроется диалоговое окно 

Plotter Configuration Editior (Редактор конфигурации плоттера) 

(рис. 75). 
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Рисунок 75 – Диалоговое окно Plotter Configuration Editor  

(Редактор конфигурации плоттера) 

 

Данное окно содержит три вкладки, на которых находятся 

различные параметры редактируемого плоттера. На вкладке 

General (Общие) можно только просмотреть информацию и при 

необходимости добавить в поле Description (Описание) дополни-

тельную информацию. Вкладка Ports (Порты) предназначена для 

определения портов для связи плоттера с компьютером. Вкладку 

Device and Document Settings (Настройки устройства и докумен-

та) можно назвать основной, так как здесь расположено боль-

шинство параметров плоттера. Данный набор параметров зависит 

от модели печатающего устройства, при этом вид нижней части 

данной вкладки зависит от выбранного элемента в списке сверху. 
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Щелкнув на кнопке OK, сохраняются изменения в редакти-

руемом файле и окно можно закрыть. Если нужно создать файл с 

новым именем, необходимо щелкнуть на кнопке Save As (Сохра-

нить как). Так можно создать несколько конфигураций для одно-

го печатающего устройства под различными именами. Щелчок на 

кнопке Defaults (По умолчанию) отменяет все выполненные и 

несохраненные изменения. 

 

1.2.3 Печать чертежа 

 

Прежде чем приступать к печати, необходимо удостове-

риться в том, что принтер или плоттер включен и подсоединен к 

компьютеру. Проверьте также, что в него заправлена бумага. 

Печать выполняется из диалогового окна Plot (Печать) 

(рис. 76), которое запускается при нажатии кнопки Plot (Печать) 

в группе Plot (Печать) на вкладке Output (Вывод) ленты или с 

помощью команды File > Plot (Файл > Печать), а также стандарт-

ного сочетания клавиш Ctrl+P. Чтобы получить доступ к допол-

нительным настройкам или, наоборот, скрыть их, нужно щелк-

нуть на кнопке More Options (Дополнительные параметры) с 

изображением стрелки в правом нижнем углу.  

Несложно заметить, что данное диалоговое окно практиче-

ски идентично окну Page Setup (Параметры страницы) (см. 

рис. 77), поэтому установлены настройки печати в процессе ком-

поновки листа, то все они появятся и в окне Plot (Печать). Одна-

ко вывести чертеж на печать можно только из окна Plot (Печать). 

В большинстве случаев печать следует производить из про-

странства листа. Вкладку Model (Модель) можно использовать 

для черновой печати. 
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Рисунок 76 – Диалоговое окно Plot (Печать) 

 

 
 

Рисунок 77 – Диалоговое окно Page Setup  

(Параметры страницы) 
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Может случиться так, что ваш чертеж на бумаге будет вы-

глядеть не так, как на экране. Поэтому рекомендуется выполнять 

предварительный просмотр. В обоих диалоговых окнах присут-

ствует кнопка Preview (Просмотр), нажав которую можно уви-

деть, как будет выглядеть чертеж на бумаге. Кроме того, в группе 

Plot (Печать) на вкладке Output (Вывод) ленты есть кнопка 

Preview (Просмотр), которая выполняет аналогичную функцию. 

Из контекстного меню, которое вызывается щелчком правой 

кнопки мыши в режиме просмотра, можно вызвать команды пе-

чати, панорамирования, масштабирования и выхода из режима 

предварительного просмотра. 

Удостоверившись в правильности настроек и в том, что 

принтер готов к печати, нужно щелкнуть на кнопке OK, чтобы 

распечатать чертеж. 
 

2. Практическая часть 

 

Изучив теоретические основы графического пакета Autocad, 

будущий инженер должен научиться выполнять горно-

графическую документацию на ПК. Поэтому предлагается вы-

полнить графическое задание «Построение рабочего уступа и его 

элементов». Задание выполняется в пространстве модели и 

оформляется на печать на лист формата А4. Пример графическо-

го задания «Построение рабочего уступа и его элементов» пред-

ставлен на рисунке 78. 

 

3. Вопросы для самоконтроля 

 

1. Дайте определение термину «стиль печати». 

2. Какие стили печати вы знаете, их краткая характеристи-

ка? 

3. Расскажите алгоритм создания таблицы стилей печати. 

4. Как редактировать таблицу стилей печати? 

5. Как осуществить подключение таблицы стилей печати к 

чертежу? 

6. Как присоединить стиль печати к слою или объекту? 

7. Как вывести чертеж на печать? 
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Рисунок 78 – Пример графического задания  

«Построение рабочего уступа и его элементов» 
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Лабораторное занятие № 10 

«Построение технологической схемы торцевого забоя  

мехлопаты при погрузке горной массы в автотранспорт  

на уровне стояния (отработка мягких и плотных пород)» 
 

Цель занятия: 

- выполнить построение технологической схемы торцевого 

забоя мехлопаты при погрузке горной массы в автотранспорт на 

уровне стояния (отработка мягких и плотных пород). Разбор кон-

кретного примера графической работы. 

 

1. Теоретические положения 

 

В карьераx выемка из массива (развала или разрыхлённого 

слоя), перемещение и разгрузка горной массы в транспортные 

средства, т.е. выемочно-погрузочные работы (далее по тексту 

ВПР) – один из основных технологических процессов на карье-

рах.  

ВПР осуществляются в забоях, которыми в зависимости от 

типа машин служат горизонтальные поверхности разрабатывае-

мого горизонта, торец заходки или откос уступа. Геометрические 

параметры забоев и заходок зависят от способа подготовки гор-

ных пород к ВПР, их технологии, параметров и расположения в 

забое выемочно-погрузочного и транспортного оборудования c 

учётом обеспечения безопасных условий работы и максимально 

экономичного эффекта.  

B зависимости от положения забоя относительно уровня 

стояния выемочно-погрузочной машины выделяют ВПР c верх-

ним (забой находится выше уровня стояния машины), нижним и 

смешанным (нижним и верхним) черпанием. Различают также 

ВПР c погрузкой горных пород на уровне стояния, верхней и 

смешанной. B первом случае (на уровне стояния) транспортное 

оборудование расположено на одном уровне (отметке) c выемоч-

но-погрузочной машиной, во втором – выше. Смешанная погруз-

ка включает (одновременно или поочерёдно) как погрузку на 

уровне стояния, так и верхнюю погрузку на промежуточный 

транспортный горизонт. Преобладающее распространение полу-



119 

 

чили ВПР c погрузкой на уровне стояния выемочно-погрузочной 

машины.  

ВПР выполняются выемочно-погрузочными машинами цик-

личного (одноковшовые экскаваторы и погрузчики) и непрерыв-

ного (роторные и цепные экскаваторы) действия. Выбор выемоч-

но-погрузочного оборудования производится одновременно по 

всей технологической цепочке – от буровзрывных работ до пунк-

тов разгрузки. 

Из всех типов одноковшовых экскаваторов наиболее часто 

на карьерах применяются прямые мехлопаты (рис. 79) и драглай-

ны. При этом при выполнении ВПР по мягким и плотным поро-

дам прямыми мехлопатами c расположением транспортного 

средства на горизонте установки экскаватора высота забоя (усту-

па) не превышает максимальную высоту черпания экскаватора.  

 

 
 

Рисунок 79 – Схема выемки вскрыши одноковшовым  

экскаватором c погрузкой в автотранспорт 

 

2. Практическая часть 

 

Практическое задание заключается в построении техноло-

гической схемы торцевого забоя мехлопаты при погрузке горной 

массы в автотранспорт на уровне стояния (отработка мягких и 

плотных пород) по предложенному варианту в графическом ре-

дакторе AutoCAD. Пример графической работы представлен на 
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рисунке 80. 

3. Вопросы для самоконтроля 

 

1. Дайте определение слоя. 

2. Применение слоев. 

3. Свойства слоев. 

4. Как сделать слой текущим? 

5. Основные свойства геометрических объектов. 

6. Из каких частей состоит панель свойств? 

7. Как изменить принадлежность к слою? 

 

 
 

Рисунок 80 – Пример графического задания «Построение 

технологической схемы торцевого забоя мехлопаты при погрузке 

горной массы в автотранспорт на уровне стояния  

(отработка мягких и плотных пород)» 
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Лабораторное занятие № 11 

«Построение технологической схемы работы мехлопаты  

при разработке мягких пород в траншейном забое  

(верхним черпанием и погрузкой в средства транспорта  

на уровне стояния экскаватора)» 

 

Цель занятия: 

- выполнить графическое задание «Построение технологи-

ческой схемы работы мехлопаты при разработке мягких пород в 

траншейном забое (верхним черпанием и погрузкой в средства 

транспорта на уровне стояния экскаватора)» 

 

1. Теоретические положения 

 

Для выполнения графического задания данного лаборатор-

ного  занятия при необходимости рекомендуется воспользоваться 

теоретическим материалом лабораторных занятий №2 – №6. 

 

2. Практическая часть 

 

Практическое задание заключается в построении техноло-

гической схемы работы мехлопаты при разработке мягких пород 

в траншейном забое (верхним черпанием и погрузкой в средства 

транспорта на уровне стояния экскаватора) по предложенному 

варианту в графическом редакторе AutoCAD. Пример графиче-

ской работы представлен на рисунке 81. 

 

3. Вопросы для самоконтроля 

 

1. Для  каких команд необходимо настроить стиль? 
2. Команды черчения (привести примеры)? 
3. Значения опции «расположения» команды мультилинии. 
4. Команда и опции для создания ПСК. 
5. Команды редактирования (привести примеры)? 
6. Команды удаления части геометрического объекта? 
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Рисунок 81 – Пример графического здания 

 «Построение технологической схемы работы мехлопаты  

при разработке мягких пород в траншейном забое  

(верхним черпанием и погрузкой в средства транспорта  

на уровне стояния экскаватора)» 
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Лабораторное занятие № 12 

«Технологическая схема работы мехлопаты  

при разработке мягких пород в траншейном забое (верхним 

черпанием и верхней погрузкой в средства транспорта)» 

 

Цель занятия: 

- выполнить графическое задание «Технологическая схема 

работы мехлопаты при разработке мягких пород в траншейном 

забое (верхним черпанием и верхней погрузкой в средства транс-

порта)» 

 

1. Теоретические положения 

 

Для выполнения графического задания данного лаборатор-

ного занятия при необходимости рекомендуется воспользоваться 

теоретическим материалом лабораторных занятий №2 – №8. 

 

2. Практическая часть 

 

Практическое задание заключается в построении техноло-

гической схемы работы мехлопаты при разработке мягких пород 

в траншейном забое (верхним черпанием и верхней погрузкой в 

средства транспорта) по предложенному варианту в графиче-

ском редакторе Autocad. Пример графической работы представ-

лен на рисунке 82. 

 

3. Вопросы для самоконтроля 

 

1. На  какие 3 основных типа делятся виды размеров в Au-

toCAD? 

2. Возможно ли открытие файла AutoCAD 2012 более ран-

ней версией AutoCAD? 

3. Какие существуют типы видовых экранов? 

4. Какое количество сторон могут иметь многоугольники, 

формируемые командой POLYGON? 

5. Какая команда формирует прямую (луч)? 
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Рисунок 82 – Пример графического задания  

«Технологическая схема работы мехлопаты при разработке 

мягких пород в траншейном забое (верхним черпанием  

и верхней погрузкой в средства транспорта)» 
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Лабораторное занятие № 13 

«Схема проведения разрезной траншеи по мягким породам 

нижним черпанием гидравлическим экскаватором типа об-

ратная лопата с погрузкой на уровне стояния экскаватора» 

 

 Цель занятия: 

- выполнить графическое задание «Схема проведения раз-

резной траншеи по мягким породам нижним черпанием гидрав-

лическим экскаватором типа обратная лопата с погрузкой на 

уровне стояния экскаватора» 

 

1. Теоретические положения 

 

Для выполнения графического задания данного лаборатор-

ного занятия при необходимости рекомендуется воспользоваться 

теоретическим материалом лабораторных занятий №2 – №8. 

 

2. Практическая часть 

 

Практическое задание заключается в построении схемы про-

ведения разрезной траншеи по мягким породам нижним черпани-

ем гидравлическим экскаватором типа обратная лопата с по-

грузкой на уровне стояния экскаватора по предложенному вари-

анту в графическом редакторе Autocad. Чертеж выводится на пе-

чать на лист формата А3. Пример графической работы представ-

лен на рисунке 83. 

 

3. Вопросы для самоконтроля 

 

1. Какие значения углов полярного отслеживания может за-

давать пользователь? 

2. Какому значению толщины линии в миллиметрах соот-

ветствует нулевое значение веса линии в пространстве модели? 

3. Объекты, расположенные на невидимых слоях отобража-

ются на экран и выводятся на плоттер ______? 

4. Какой слой создается автоматически при создании нового 

рисунка? 
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5. Вес (толщина) линии Default, по умолчанию, соответству-

ет какой толщине? 

 

 
 

Рисунок 83 – Пример графического задания  

«Схема проведения разрезной траншеи по мягким породам ниж-

ним черпанием гидравлическим экскаватором типа обратная ло-

пата с погрузкой на уровне стояния экскаватора» 



127 

 

Лабораторное занятие № 14 

«Бестранспортная схема с установкой драглайна на развале» 
 

 Цель занятия: 

- выполнить графическое задание «Бестранспортная схема 

с установкой драглайна на развале» 

 

1. Теоретические положения 

 

Для выполнения графического задания данного лаборатор-

ного занятия при необходимости рекомендуется воспользоваться 

теоретическим материалом лабораторных занятий №2 – №8. 

 

2. Практическая часть 

 

Практическое задание заключается в построении бестранс-

портной схемы с установкой драглайна на развале по предложен-

ному варианту в графическом редакторе Autocad. Чертеж выво-

дится на печать на лист формата А4. Пример графической работы 

представлен на рисунке 84. 

 

3. Вопросы для самоконтроля 

 

1. Какую клавишу необходимо нажать для отмены какой-либо 

команды? 

2. Какое расширение имеют файлы шаблонов? 

3. В каком диалоговом окне осуществляется процесс настройки 

рабочего пространства?  

4. К какому результату приводит нажатие клавиш Ctrl+O? 
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Рисунок 84 – Пример графического задания 

«Бестранспортная схема с установкой  

драглайна на развале» 
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Лабораторное занятие № 15 

«Схема работы мехлопаты при разработке  

взорванных пород в траншейном забое при погрузке  

на уровне стояния экскаватора» 
 

 Цель занятия: 

- выполнить графическое задание «Схема работы мехлопа-

ты при разработке взорванных пород в траншейном забое при 

погрузке на уровне стояния экскаватора» 
 

1. Теоретические положения 

 

Для выполнения графического задания данного лаборатор-

ного занятия при необходимости рекомендуется воспользоваться 

теоретическим материалом лабораторных занятий №2 – №8. 

 

2. Практическая часть 

 

Практическое задание заключается в построении схемы ра-

боты мехлопаты при разработке взорванных пород в траншей-

ном забое при погрузке на уровне стояния экскаватора по пред-

ложенному варианту в графическом редакторе Autocad. Чертеж 

выводится на печать на лист формата А3. Пример графической 

работы представлен на рисунке 85. 
 

3. Вопросы для самоконтроля 

 

1. Типы линий на чертежах открытых горных работ и их 

назначение. 

2. Обозначение откосов и насыпей. 

3. Общие правила обозначения поверхности откоса уступа. 

4. Обозначения откосов уступов на различных горных объек-

тах. 

5. Обозначение угольных пластов в профиле и плане горных 

выработок. 

6. Изображение и обозначение развала на профиле и плане 

паспорта забоя. 
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7. Упрощенное изображение оборудования. 

 

 
 

Рисунок 85 – Пример графического задания  

«Схема работы мехлопаты при разработке  

взорванных пород в траншейном забое при погрузке  

на уровне стояния экскаватора» 
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